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Introduction to RockWorks

RockWorks is a program for managing borehole data and datasheet data. It is used to
create base maps, contour maps, cross-sections, 3D surfaces, 3D solid block models, and
fence diagrams. The main screen consists of the following components.

e Title bar

0 Includes the version in YYYY.MM.DD format and "top shelf" tools including
Search, License management, Favorites menu, RockPlot2D, RockPlot3D,
ReportWorks, Window switcher, Setup menu, Help, Multiscreen,
Maximize, Minimize, single screen Maximize/Restore, Exit, and Layout
tools.

¢ Project Folder
0 Open recent or new project, subsite selection.
e Project Settings

0 Includes a Summary of coordinate system, XYZ project dimensions and
extents, and tools to change or scan dimensions and coordinate units, add a
background image, and add notes.

e Operations Ribbon (Program Ribbon)

0 Borehole Operations to make maps, models and cross-sections, ModOps to
make models from the Datasheet, Utilities to create maps and plots from the
Datasheet data, Graphics tools to embellish and modify images
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o Manager tabs and contents

0 Includes the Project Manager tab with a list of tables and RockWorks files,
the Borehole Manager tab for entering and viewing borehole data, the
Datasheet tab for entering and viewing data in a datasheet, the Faults tab for
importing and viewing faults, the Playlist tab for automating multiple
operations, the Videos tab for viewing instructional videos, and the Execution
History tab for viewing a log of program activity.

0 Tabs can be dragged to separate windows and docked back on the main
window.

e License Status Bar

0 Includes the license status, copyright information, and maximize tools.
Display of many of these tabs is controlled by small # and = buttons.

The following exercise illustrates the process of creating a new project and importing
data from Excel.
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Exercise 1: Start a New Project and Import Data
Step 1: Open a Project Folder

e Open RockWorks 2020 by clicking the on the RockWorks 2020 shortcut on the
desktop, or click on the Windows Start button, type RockWorks, and choose the
RockWorks20 64-bit item.

The program opens the project in the \Documents\RockWorks Data\Samples\ folder in
your Windows User folder.

RockWorks data are stored in the Borehole Manager database with tables for each type of
data associated with boreholes, or in the Datasheet with rows and columns of data. We
will create a new project and import data into the Borehole Manager database.

e Click Project Folder | New to display the Create New Project Wizard dialog box.

Fa| RockWorks 2020

Version 2020.6.12
& Project Folder: ‘ Ch\Users\TomB\Do

e
Open ...
5| & Recent ...

e Accept the default location for the project folder
(C:\Users\<username>\Documents\RockWorks Data\New Project\), or click on the

yellow folder icon on the right /= to specify a different folder, or type in a new folder
name. Click Next to accept the other defaults and proceed to the Project
Coordinates tab.

RockWorks Training Manual 3



In the Horizontal
(XY) Coordinates
and Units section,
verify that the
coordinate system is
set to UTM.

Verify that the datum
is WGS-84 1984 and
the Zone is set to 13
(Northern
Hemisphere).

Verify that the UTM
Units are set to
Meters.

In the Vertical (Z)
Units section, verify
that the units are set to
Meters.

Since the XY and Z
coordinates are set the Meters, the Output coordinates are set to Meters.

Click Finish to display the Confirm dialog box. Verify that the settings are correct,
then click Yes. RockWorks will build a new project SQLite database in the specified
folder. The database file will be named New Project.sqlite to match the \New Project\
folder name.

The new project has no boreholes or data, and the extents are set to 0-100 for X, Y,
and Z. Proceed to the next step to import data from Excel.

Step 2: Import an Excel Workbook into the Borehole Manager Database

One of the formats that RockWorks imports is the "multi-sheet" Excel format. This
format mirrors the database format. Excel sheets correspond to the database tables in
RockWorks, and columns correspond to different fields in each table. In this exercise we
will view the file in Excel, and import it into the new project created in Step 1.

Open Excel and choose the SamplesTraining01.xlIsx file from the folder
C:\Users\<username>\Documents\RockWorks Data\Samples. Note that the tabs at the
bottom of the Excel window have names that correspond with tables in RockWorks.
The columns on the Location tab in Excel correspond with fields in the Location
table in RockWorks. Required fields include the following:

O A unique Borehole Name or ID.

0 Easting and Northing coordinates for XY location.
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0 Elevation for the default reference for calculating elevation from depth, often
the ground elevation or top of PVC stickup pipe.

0 Total Depth, representing the positive bottom hole depth (measured depth)
below the reference elevation.

e Close Excel and switch to the RockWorks window to import the Excel file.
RockWorks uses Excel to read the data and send it to RockWorks.

e In RockWorks, choose File | Import | Excel | Multiple Tables.

e The Confirm window prompts to backup the database. Click Yes, then OK to accept
the default name. The backup with the database and menu settings is saved in a ZIP
file and the Excel Import Wizard is displayed.

At the Import Filename prompt, click on the yellow open folder icon < on the right
side of the pane. Navigate up one level to the \RockWorks Data\ folder, double-click on
the \Samples\ folder, select the file SamplesTraining01.xls and click Open. RockWorks
reads the Excel file and displays the Block Selection tab.
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The Block Selection tab matches the Excel sheet names on the left column with the
target RockWorks database table names in the right column. The names match
automatically in this file, but you can click on the table name or blank cell in the RW
Database Tables column to display a dropdown list of all the table names. When you are
entering data to your working project you may need to specify the matching tables.

e C(Click the Next button at the bottom of the window to proceed to the Data
Coordinates tab, or click directly on the Data Coordinates tab.

e The Data Coordinates tab prompts you to specify the coordinate system of the
incoming data. Verify that the Horizontal (XY) Coordinates and Units are set to:

UTM

Datum = WBS-84 1984 (NAD-83)
Zone = 13 (Northern Hemisphere)
Units: Meters

o O O O
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e Verify that the Vertical (Z) Units are set to Meters.

e C(Click the Next button at the bottom of window to proceed to the Location Fields tab,
or click directly on the Location Fields tab.

Map Borehole Location Data
Determine how the input fields are mapped to the "Location” table's fi

File Selection | Block Selection | Data Cc:-c:-rdinatesq Location Fields ._D

@olumn from Input File —9@1‘\!’ Database Fie@

Bore Borehole Name

Easting Easting

Northing Northing

Elevation Elevation

TotalDepth Total Depth Click in this

column for a
dropdown list
of available
fields.

API
Well Status

< add new field =
Borehole Mame
Collar Elevation
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e The Location Fields tab lets you assign the columns in the Location sheet in Excel
to the fields in the Location table in RockWorks. By default, only the Location table
has this option enabled. (If needed for other tables, enable this option for the selected
table on the Block Selection tab | Show Block Mapping button.) In addition, the
Location Fields tab lets you specify how to handle the import of new data to existing
boreholes.

The column names match automatically in this example, and you can click in the right
column for a dropdown list of available fields.

e The Borehole Overwrite Option section specifies how to handle data import for
existing boreholes.

(0]

Skip Existing Borehole will not import data Borehole Overwrite Option

if the borehole already exists in the database. R

) Skip Existing Borehole
Create New Borehole will create a new
borehole if one already exists so you can
review the data before deciding which one to O Replace Existing Borehole

keep.

® Create a New Borehole

O Update Existing Borehole
Replace Existing Borehole will delete the

existing borehole and import the new data. o
¥l Warn on Existing Borehole

Update Existing Borehole will add new
data to existing boreholes.

Warn on Existing Borehole will display a message when a duplicate
borehole is found, so you can specify the behavior separately for each
borehole. This option lets you specify a particular option for all subsequent
boreholes.

e Click the Import button at the bottom of the window. When you are prompted to
confirm, click Yes to continue.

e RockWorks imports the data, then displays the Confirm | Update Project
Dimension window. Click Yes to display the Output Dimensions.

Step 3: Set the Project Dimensions

The default dimensions are 0-100 in the X, Y, and Z directions. RockWorks uses the
project dimension to create most graphic output, so before creating maps, cross-sections
and models, scan the boreholes to define the project dimensions.
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e Choose Scan | Boreholes -> Dimensions to display the Set Dimensions from
Borehole Data menu.

e For Items to be Scanned, choose All Boreholes, and click on the green button at the
bottom labeled Continue (Ctrl-G).

e Note that the calculated project dimensions change to match the borehole XYZ
coordinates in the Output Dimensions window.

Step 4: Lithology and Stratigraphy Types Tables

The Types tables define the colors and patterns for the Lithology, Stratigraphy, and other
data. The samples training Excel file includes a Lithology Types table that lists
keywords, colors and patterns. It does not include a Stratigraphy Types table, so we will
create one in RockWorks.

The Types tables are listed in the Project Manager pane on the left side of the main
RockWorks window, and in the header of each table that requires a Types table.
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Double-click on the Litho Types table in the Project Manager or single-click in the
Borehole Manager Lithology table to view the Lithology Type table.

File Edit Density Units: Undefined
G-Value Keyword Pattern Fill Percent Density Show in lLegend

3 2.0 Clay ] 100  1,600.0
50 Gravel  roed 100 1,680.0
9.0 Ignimbrite 100 1,600.0
6.0 Mudstone 100 1,800.0
8.0 Rhyolite 100 1,200.0
4.0 Sand 100  1,555.0
3.0 silt 100 1,300.0
7.0 Siltstone 100 1,3200
1.0 Soil 100  1,220.0

The data columns in the Lithology Type table are described below.

Column Data Description
Title

G-Value
The G-Value is the number the computer uses for the
Lithology type when making models. Give each Lithology a
unique number.

Keyword
Lithology name or material type. USCS or USGS soil and
rock types are often stored here.

Pattern
Choose a pattern from the RockWorks Pattern Library and a
foreground & background color.

Fill Percent
Percent of the column the pattern will fill in the strip log, this
is used to show weathering & erosional trends in 2D strip
logs.

Density
Density of the material, used for calculating mass. Look up a
reasonable density value for your material type.

Show in

Legend If this box is checked, the keyword and pattern will be
displayed in legends created by the program.
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Click on a column header in the Lithology Type table to sort on that column. For
example, click on the G-Value header to sort the table in ascending order based on the
numeric value.

e Close the Lithology Type table by clicking OK in the lower left corner, or the [X] in
the upper right corner.

¢ Open the Stratigraphy Type table by double-clicking the Strata Types in the Project
Manager, or single-clicking the Strata Types button in header of the Stratigraphy
table in the Borehole Manager tab.

The table lists five formations with unique Order, Pattern and colors. The names in the
Formation column are added from names found in the Stratigraphy sheet in the imported
Excel file.

RockWorks Training Manual 11



Exercise 2: Use RockWorks to View Your Raw Data

This exercise shows you how to view your observed data stored in the Borehole Manager
using strip logs, cross-sections and other tools.

Step 1: Create a Site Map of your Project Area

e Return to the \Samples\ project for the remainder of the exercises. Click on the
Borehole Manager tab at the top of the program window. Click on the Folder |
Recent Projects menu in the upper left corner of the main RockWorks20 window
and choose the C:\Users\...\RockWorksData\Samples\ folder.

e Click on the QuickMap tab to the right of the Borehole Data tab to display a quick
view of your borehole data. The currently selected borehole is highlighted with a red
square. The QuickMap is a good way to find bad coordinate values. Click on the
Borehole Data tab to return to the Location table and other database tables.

e For a more complete map that can be exported and printed, choose the Borehole
Operations | Map | Borehole Map option.

e Click on the Main Options | Symbol Options button to view options for these items.
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<]

Symbols

<l

Log Traces
Borehole IDs

Coordinates

<]

Elevations

Collar Elevations
Total Depths
Stratigraphy Data
Aquifer Data
T-Data

Optional Fields

aOooOn0onnan

-

e Click on the Label Options tab to display different settings for labels on the map.
Here, the user can specify font size, color, and a number of other options.

e Choose a font size (somewhere between 0.5 and 2 are typical sizes) and select a color.

Similar options are available for additional map features.

e Click on the Labeled Axes tab. Note the options for Axis Titles, Dimensions and
Manual Intervals. You’ll also see a preview for the visible titles, axes, labels, and
tick marks. Don’t change the default values already assigned by the program. The
values already assigned should work fine.
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e Click through the additional features in the Borehole Location Map options window,
to see what you can add later in your work.

e Click on the Continue button across the lower portion of the window to process and
display the borehole map in a new tab.
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=] @=m
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o =oms e
Easting

RockWorks maps and other 2D graphics are plotted in this type of plotting window,
called the RockPlot2D window.

e Now the map is open, experiment with selecting and moving text items in the map.
To do this, position the cursor on the item and left click on it to select it. The selected
item will be displayed with handles on each corner. To move that item, use your left
mouse button to drag it to its new location.

e If you would like to change a global variable in the map (for example, if you would
like to make all of the symbols in the map a larger size), then adjust them by clicking
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on the Options tab at the top, make desired changes in the settings tabs, and re-click
the Continue button.

e Once you’ve created a map that you like, save the map as a Rw2D file by going to the
File | Save menu at the top of the window. Name the file Site Map.Rw2D and save it
to the following location: \Documents\RockWorksData\Samples\

e Close this entire window by clicking on the "X" button in the top right-hand corner of
the window.

Step 2: Create a Single Strip Log
In this step, you will create a strip log of a single boring. This is useful if you want to
view many types of data at one time.

e Make sure that DH-01 has a black triangle to the left of the check box to indicate it is
selected in the Borehole Manager program tab near the center of the screen.

e Click on the Striplogs menu and choose 2D Strip Log at the top of the list.

The 2D Striplog options window will list some menu options in the panel to the left:
Borehole ID, Vertical exaggeration, and View Direction. The selections below in the
list will be activated by a check box next to them and contain additional options for
display. Explore these by clicking on the tabs.

Also notice the Output Options tab which allows you to Display, Save, and/or Export
your completed Striplog.

Across the top are tabs to set up your 2D log;
e (lick on the 2D Log Design tab.

This window is where you establish which data items will be displayed in the 2D log.
You can also adjust column placement and appearance settings for each column.

RockWorks Training Manual 15



All

checked
items in
this list will To rearrange an

be item, click on it
displayed ‘ ’ and then drag it
in the to the left or right
Layout

Preview to
the right

H

e To activate an item, click on the check box to add a check mark. It will be displayed
in the upper Preview pane as a column.

e To reposition the item, click on it in the Preview pane, and drag it to the right or left.

e To view/adjust an item's settings, click on its name in the column on the left, and
modify the settings as necessary in the Options pane in the bottom right.

e In the 2D Log Design window, insert check marks for the following items. All of the
other items should be unchecked.

Title
Depths
Lithology

UBNCURNCURRCY

Stratigraphy
Well Const.

Fractures

UV

Aquifers

<]

Bitmaps
I-Data #1 and I-Data #1 Text
P-Data #1

KUY

e Use your mouse to adjust column locations by selecting different columns and
clicking and dragging them around the Layout Preview Pane. Note that the LOG
TITLE will always be centered over the red vertical line representing the log Axis.

e View the options for the P-Data #1 column by selecting the row in the left pane (be
careful not to uncheck the item when you select it), or by clicking on the curve
column in the Preview pane.
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In the Options pane to the bottom right, the Track item gives you the option to choose
which column in the P-Data table will be used to create the curve. The down-arrow is
used to choose the track name. The red and blue icon to the right in the track row opens
the Types Table if you want to add another P-Data track on the fly.

e Select the Gamma track.

e Click on Fill Options tab to change color and line styles by clicking on the color and
line boxes.

Similar options are available for plotting bar graphs using data from the [-Data and T-
Data tables.

e Click on the Lithology item in
the visible items list, to view the
Lithology Options on the lower
right. Here you can view or
change the column width, title
name and font style. Leave
everything as it is.

e C(Click Continue at the bottom of
the 2D Striplog window. A log
that looks similar to the one to
the right is displayed in a new
RockPlot2D tab.

e If you have time, you can
experiment with different
settings in the 2D Log Design
tab, and click on the Continue
button to recreate the log with
the changes applied.

e Close the 2D Striplog window, you do not need to save the Rw2D file this time.
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Step 3: Create a Striplog Cross-Section

e Choose the Striplogs | 2D Striplog Section menu option.

¢ In the menu options to the left, review the categories by clicking on the tab names and
viewing the options on the right. You can add details around your striplog section by
clicking the boxes.

e Click on the 2D Log Design tab to display striplog options.

e Make sure that only the following items are enabled in the visible items listing:
W Title

¥ Lithology
¥ Stratigraphy
i P-Data #1

e Uncheck everything else.

Wisible Ttems Layout Preview
Stratigraphy |:| Text - LOG TIILE
] well Const. [ Text —j—_"—E
e [ {
[ rpata=r [ Text e ﬁ
i ]
I-Data #2 Text e i
D ata |:| [ i |
[F] 1-Data #3 [ Text e
Pl
[[] 1-Data =4 O] Test N i)
= 5
[[] 1Text#1 E"’,-i 7
[ 1-Text #2 5? f’::
[ 1Text#3 il e
[F] 1-Text #4 1 5 5
[7] T-Data#1 [ Text —
[7] T-Data =2 [ Text P-Data Curve #1 Options
[l T-Data#3 [ Text e[ B[ T ] wrep
[ T-Dataszs  [] Text << 22| € > |
P-Data #1 =lppE Track Gamma
A |— Filter Based On Opt\UI"IS
[7] P-Data#2 E G-Values
Resample At
[C] P-Data#3 ™ Regularly-Spaced Options ...
] P-Data#4 Intervals
Column Layout Options ...
[ PText#1 Scaling Options ...
[[] PText#2 Fill Options Options ...
[[] P-Text#3

e Next, click on the Section Location tab at the top, next to the 2D Log Design tab.

e Use your mouse to pick a borehole-to-borehole cross-section line that trends North-
South across the area. Note that the XY coordinates of each vertex along the line are
listed to the right.
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e Checkthe  Location Map option on the next tab to the right, to generate a section
location map along with the diagram. Click the tab and review the options you want
within the map; Labeled Axes, Borehole Locations, Background Image, ctc. Be

sure to click on the Output Options, and choose to g Display Map as Separate
Diagram.

¢ Click Continue at the bottom of the window.
Two new untitled tabs appear, displaying a cross-section with legends and a borehole
location map. You can save the diagrams to update the tab name.

e C(Click on the tab displaying the Striplog Section and move the mouse over your cross-
section to display the X and Y coordinates at the bottom of the window. X is distance
along the cross-section and Y is elevation.
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Let’s recreate this section quickly, with one change to the Stratigraphy settings.

e Click on the Options tab to the left, to return to the settings.

e Remove the check mark from the ' Location Map tab at the top.
e Click on the 2D Log Design tab.

e Click to add a check mark inthe  Stratigraphy Text item. In
the Options to the right, click Interval Labeling. Be sure that the
following options are checked on.

¥ Keywords
¥ Borders

Remove the check marks from the other items.

e Once you’ve made these changes, click Continue.

=

i

The resulting section should have formation names plotted next to each Stratigraphic
interval.

e Close the 2D Striplog Section window, you do not need to save the Rw2D file at this
time.

Step 4: Create a Striplog Profile

In this step, you will create a second kind of cross-section called a "Profile". Instead of
creating a cross-section polyline from hole to hole, you will be choosing a single line that
defines a vertical plane. The program will project selected logs onto that plane and plot
them as a diagram.

e Choose the Striplogs | 2D Striplog Profile option.

Notice that the program has remembered many of the choices you made in the previous
step.

e Add acheck mark to the  Location Map tab at the top of the window, to reactivate
this map.

e Click on the Profile Location tab, where you will define the wells in your profile.

20 RockWorks Training Manual - Exercises



e Uncheck the "' Snap box so that the profile line will not be snapped to the borehole
locations.

e Use your mouse to draw a line that starts just to the south of DH-27 and trends due
north past DH-39.

e C(Click Continue at the bottom of the window.

Two new RockPlot2D tabs named Untitled are displayed.

e Click on the tab displaying your profile location map and save it by selecting File |
Save As and entering a name of your choice.

e C(Click on the tab containing your profile diagram. You should see an image that looks
similar to the figure below. The left side represents the first point that you clicked to
start the profile. Notice that with this type of diagram, the program shows the true
geometry of your boreholes.
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e To add a legend to the profile diagram click Draw | Insert, and choose Stratigraphy
Legend. You will click on the window and drag a box to draw your legend in.

e After the legend is drawn click the Edit button P which allows you to select items,
and resize and reposition them. Double click in the legend box to open Attributes and
adjust dimensions, text, etc:

e Save your profile by choosing File | Save and enter the name: Log Profile. Rw2D.
Step 5: Export your cross-section to a DXF file

This step shows you how to export your cross-section to a DXF file. This allows you to
add more detail, or draw your own correlations in AutoCAD.

e On the log profile tab, choose the File | Export | DXF menu option.

e Click on Output File to specify the file name. Choose Manual and enter into the
prompt the name: Sample Export.dxf.

e ! Display Output Within AutoCAD: Uncheck this option for now.
e Click on the DXF Options tab to explore various DXF output settings.
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The program allows you to export your DXF file using the original x and y coordinates of
the profile. It also allows you to rescale with a specific vertical exaggeration and with
completely new origin coordinates. For this section, we’ll set the vertical exaggeration to
"1", but remember that you can apply stretch in your own work. This is useful because
AutoCAD does not easily allow for rescaling of x and y independently.

Next let’s take a look at the layering options you have when creating the DXF file.

e Review the Layers section of this window.

You have the option to create a single (combined) layer or to break the image down into
separate layers.

o Separate: Let’s assume that your CAD department will want your DXF broken
up into separate layers so choose this option.

e RockWorks gives you the option to turn on and off different types of objects. The

program has the user specify a Root Name for all layers and different Names for
each layer.

e Once you have explored your options, click Continue to create the DXF file and
close the window. See the Help pane for explanation of the other export options.

e Close the 2D Striplog Profile window, there is no need to save these Rw2D files.
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Step 6: Create a 3D View of your Logs

This step will introduce you to the RockPlot3D viewer. We will create a few different

images that can be used in future exercises.

e Choose the Striplogs | 3D Striplogs option from the main RockWorks program
window. You will see the Multiple 3D Striplogs window with menu options in the

panel to the left, and tabs across the top.

In the 3D Log Design tab, you can
establish which data items will be
displayed in the 3D logs, their relative
placement in the log, and their
appearance settings.

To activate an item, insert a check in
the check-box for that item. It will be
displayed in the upper Layout Preview
pane as color- and letter-coded circles.

To reposition the item, click on it and
drag it to any location in the Layout
Preview. The offset from the log center
or axis will be updated in the item's
Options settings (lower pane).

To view/adjust an item's settings, click

on its name in the 3D Striplog Designer

column, and modify the settings as
necessary in the Options pane to the
right.

e Check on the following items in the visible items listing.

W Title
W Axis
¥ Lithology

|

Visible items will be
displayed here, in an
overhead view. Drag to
change their
placement around the
log and to change size.

Clickon a
Visible item to
view/change
its options.

List of available log items. Show items by
inserting a check in its check-box.

24

All of the other items should be checked off.

Click on the Lithology item. Notice that the Lithology Options displayed in the
panel to the bottom right change to show those specific to the Lithology column.

Click on the Column Radius field and change the radius to 1.0.

Click on the Main Options tab at the top left of this window, to access the general
diagram settings. Check on the following items:

¥ Perimeter Cage
¥ Legend(s)
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The other diagram layers can be unchecked.
e Click Legend(s) tab. Add a check mark to the following item.
Aquifers

Color

<

Lithology
Stratigraphy

Well Construction

[ . -

Automatic Spacing

e C(Click Continue.

A new tab that contains the RockPlot3D viewer is added to the window.

Let’s expand the window so that it takes up most of your screen. Note that you can move
the divider between the object list (which starts with the Reference heading) and the
image by dragging your mouse. Reposition the divider so that the majority of the
Window is used to view the 3D scene.

Now, let’s take a look at the data in the 3D viewer.

e Adjust the zoom settings by typing in or selecting a new zoom factor in the top center
of the window.

e Give the scene a vertical exaggeration of 2 by choosing the View | Dimensions menu
command. Enter 2 in the Vertical Exaggeration field and click Apply. Click on the
Close button once you have an idea of how the vertical exaggeration in the viewer
works.
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Experiment with the other buttons at the top of the Window: Practice rotating the 3D
scene by dragging your mouse. Return to the default view by double-clicking on the
Default View item in the object list or choose the View | Above | South-East menu
option. If you have questions about the functions of the buttons, ask your instructor.

Choose File | Save and save your RockPlot3D view as Lithology Logs.Rw3D. Make
sure that you save this in the \Documents\RockWorksData\Samples\ directory.

In this last step, you’ll make one more 3D scene, this time showing downhole
geochemistry concentrations. This is very useful when looking at 3D contaminant
concentrations, or any other parameter that will eventually be used to create a solid
model.

At the top of the 3D window, click on the Options tab, and then below that click the
3D Log Design tab.

Turn off the Lithology item and turn on I-Data #1.
W Title

M Axis

" Lithology

i I-Data #1

The I-Data #1 Options should be displayed in the pane to the lower right. Work top to
bottom through the list, as you click the name the parameters related to that tab will
populate to the right.

26

On the Track tab, make sure the Benzene Soil track is selected.
Click Column Attributes tab, change the Column Radius to 4%.
Click on the Scaling tab, choose * Automatic.

Click on Appearance to see the options for Interval Labels, Color Options, Shape,
which will apply to the well bore in 3D.
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e Click Continue.

A new RockPlot3D window displays color-coded oblate shapes representing Benzene
Soil concentration measurements.

e Choose File | Save and save the 3D scene as Benzene logs.Rw3D. Make sure that it
is saved in your project folder.

e Close the Multiple 3D Striplogs window.

Extra Credit — Explore Additional Options for Plotting P-Data and I-Data
Next, we’ll explore some additional tools for plotting downhole Point and Interval-based
data.

e Select borehole DH-01 in the Borehole Manager tab, and choose the Striplogs | 2D
Striplog menu option.

e Make sure that the following items are selected in the 2D Log Design tab:
W Title
¥ P-Data #1

e Click on the P-Data #1 item to display the P-Data Curve #1 Options pane at the
bottom of the window.

e Click Fill Options.
NOTE: If you have problems seeing all of the settings, drag upward the divider
between the Preview and Options panes. You can also use the scrollbar to the right to

scroll within the pane.

Add a check mark to  Fill Region Within Curve and select * Gradational,
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change the colors and line style if you want.

e Click Continue to display a striplog with color fill varying based on Gamma values.

Next, we will adjust the fill of the P-Data column.
e Click on the Options tab in the top left, then return to the 2D Log Design tab in the

row below.
e Click on the P-Data #1 item, and click Fill Options. For the Fill Style, select
* Above Threshold, and type 25.

e C(Click Continue to display the curve with color fill at those depths where the Gamma
value is greater than 25.

Experiment with the other fill and scaling options available for P-Data, and then take a
look at the similar options for [-Data. If you have questions about any of the options, be
sure to ask your instructor since all of these options will not be covered in lectures.
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Exercise 3: Using the RockWorks Playlist

The Playlist tab in the main RockWorks program window is used to automate tasks that
you do frequently in the program. Imagine that you are starting work in a new project and
you create a borehole location map, a couple of striplog sections, and a T-Data Statistics
map showing the high values of your contaminants. As new samples and monitoring
wells are added, you can re-run these maps and diagrams with the click of a button, using
all of the same settings.

You can add items to a playlist with the click of a button in the program windows. For
example, clicking the Playlist button in the Borehole Location Map window...

Generates this item in the Playlist pane:

H videos T Project Manager L_RENEIULLEMES N 2 Bore

= EiFile «f Edit ® View fft Configure I Add

[J .~ 1Playlist ltem
New %% Borehole Location Map

Open

Save

Enable

Disable

v PROCESS PLAYLIST

RockWorks Training Manual 29



You can add multiple programs to a playlist. You can save as many different playlists as
you want. To run a playlist and generate output, just click the PROCESS
PLAYLIST button at the bottom of the list.

! The number of items - both programs and special items - you can save and run in a
single Playlist is dependent on your feature level of RockWorks:

e Basic level: 5 Items

e Standard level: 5 Items

e Advanced level: Unlimited Items

Step 1: Create a New Playlist

Use the New button or the File | New menu option to create a new, blank playlist.

e C(Click on the Playlist tab in the main RockWorks program window.
B
L}
e Click on the New button "Mewt Or select the File | New menu option at the top of the

Playlist pane.

e If'there is an existing playlist in the player and it has not been saved, you will be
prompted whether to save it. Click Yes to save the current playlist before closing,
click No to close the current playlist without saving, or click Cancel to cancel the
new-playlist operation.

A new, blank playlist will be displayed in the player.

Step 2: Add Programs to a Playlist

)
Playlist

A RockWorks Playlist is designed to automate program functions, such as creating a
borehole location map, then a cross section, then a lithology model, while you are busy
doing other things.

Follow these steps to add programs to a playlist:

e First, open the existing playlist to which you want to add items, or create a new
playlist using the icons at left in the player.

e Select the menu option you wish to add to the playlist. For example, if you want to
add a stratigraphic cross section to the playlist, you would click on the Stratigraphy |
Section | Model-Based menu option to open that program window.
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e Establish/review the menu settings for that program.

e Be sure to click on the Output Options to define whether you want to save the output
file, how it is to be named, and whether it is to be displayed.

e Optional: Click the Continue button to generate the output, and confirm the settings
are as you want.

e At the top of the program window, click the Playlist button.

e RockWorks will prompt you to assign a title for this item. The default title will come
from the program you are adding, such as "Model-Based Stratigraphy Section".
The title will be used to identify this item in the playlist.

e Accept, modify, or replace the suggested title as you like. The default title may work
well for simple playlists; you may want to enter more specific information into the
title for detailed playlists or those with many versions of the same item.

e RockWorks will add the program and its settings to the current playlist. You can
move the current program window out of the way to see the Playlist pane in the main
RockWorks window.

e Back in the program window, click the Continue button if you want to go ahead and
create the output at this time. Or click the Cancel button to return to the main
RockWorks window.

Step 3: Add Special Items to a Playlist
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As described in the previous step, the main function of a playlist is to automate program
functions. In addition to listing programs, you can also add other special items to a
playlist. These include production items such as comments, as well as mechanical items
such as opening datasheets and setting project dimensions. These items are available in
the Add menu at the top of the Playlist pane.

Follow these steps to add special item(s) to a playlist:

e Click on the Playlist tab in the main RockWorks program window.

e Open the existing playlist to which you want to add items, or create a new playlist for
the items.

e Click the Add button at the top of the playlist pane.

e In the pop-up menu you will see the list of items which are available, described
above.

e Try adding Sound Completion Notification at the end of your Playlist, to notify you
when the processes have completed. Establish the settings for that item.

e C(lick OK or Continue to add the item to the playlist.

Step 4: Edit a Playlist

Use the tools available to make changes to the items currently in your playlist. The
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options are offered as buttons along the left edge of the Playlist pane, and in the Edit and
View menus at the top of the Playlist pane.

e C(Click on the Play Sound/Synthesized Speech item you added in the last step to
highlight it for editing.

e Click the Down button on the left side, and move the sound indication to the
bottom of your playlist. The items play in order from top to bottom so this will sound
at the end of the playlist.

e Save the playlist when your editing changes are complete.

Step 5: Edit an Item in the Playlist

Double-click on the playlist item to be modified. You can only modify one playlist item
at a time.

The program will take a moment to load all of the menu options for that item. The display
of those options will look just like those in the original program window.
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Click on Symbol Options, then Symbols, to add or change how the borehole data is

displayed. You can modify labels, or click to add the elevation at the borehole, as

examples.

When you are done editing this playlist item, click one of the buttons at the top of the

pane:

¥ To save your changes: click the green Save Menu Settings and Return to
Previous Menu button.

W To cancel your changes: click the Cancel button.

Save the playlist when your editing changes are complete.

Step 6: Save a Playlist

Use the Save and Save As buttons or the File | Save, Save As menu options, to save the
current playlist.

34

Click on the Playlist tab in the main RockWorks program window.
To save the current playlist with the same name or (if Untitled) with a new name,

=

click on the Save button 5a¥& in the toolbar, or select the File | Save menu option at
the top of the Playlist pane.
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To save the current playlist with a different name, click on the Save As button Save As
in the toolbar or select the File | Save As menu option at the top of the Playlist pane.

e If prompted, type in the name for the playlist. Playlists are saved with ".RwPlaylist"
file name extensions.

The current playlist will be saved in your project folder.

Step 7: Run a Playlist

¢ Open the existing Playlist that you wish to run, or create a New Playlist and add
programs, add special items, edit the list as necessary and Save the playlist.

e C(Click on the PROCESS PLAYLIST button in the Playlist pane to run the playlist.

e RockWorks will read the programs and other instructions from the playlist and
perform the indicated operations. The requested output will be displayed in various
tabs to the right, in the RockWorks datasheet, or other requested output windows.

Tips:

X
o Use the £8se0UE hytton (along the left) or the View | Close Output Tabs menu option
to close all of the output tabs at once.

e Use the View | View Playlist as Text menu option to view the contents of the playlist
file ((RwPlaylist file).

Step 8: Export a Playlist to a Command Strip

Use your playlists as a starting point for advanced "Command Scripts" in RockWorks.

e C(Click on the Playlist tab in the main RockWorks program window.
e If necessary, open the playlist to be exported.
e Select the File | Export Command Script menu option:
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e Type in the name for the Command Script. Command Scripts are saved with
"RwCmd" file name extensions.

The command script will be saved in your project folder.

Step 9: Playlist Configuration Settings
1f+ Configure

Use the settings in the Playlist Configure menu to establish how you want the player to
operate. These are "toggle" items - click on an unchecked item to check it (activate),
click on a checked item to uncheck it (deactivate).

e Automatically Load Last-Saved Playlist When Program Starts: Check this item if
RockWorks should load the most recently-saved playlist on startup.

¢ Confirm File Save Whenever Playlist is Saved: Check this item if RockWorks is to
display a confirmation window each time you save your playlist. The window
requires user interaction - clicking the OK button - to close the confirmation window.

e Narrate: Read Aloud Each Item Title as it is Processed: Check this item if
RockWorks is to narrate with a synthesized voice each item as it is processed.

e Create New Row(s) if Tab Titles Exceed Dialog Width: Check this item if the
output tabs to the right should be stacked in rows rather than scrolling to the right if
they are wider than the program window.

Step 10: Explore Icons in RockWorks Program Windows

Use the icons at the top-right of the RockWorks program windows to help simplify
workflows. They allow you to save/load settings specific to the program that is active,
load sample datasheet files, add the current program to your favorites list, and add a
workflow to your playlist.
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Let’s review these functionalities so that you can be familiar with their purpose.

Click the Settings icon, which will show a list of options that include load, save, or
view the settings for the active program. You can also choose to use default settings.
This tool helps you to get back to your selections quickly and with less clicks than
setting it all up again for each program.

Some programs which read data from the RockWorks datasheet will have an
Examples button. Click this to view sample data files which are installed with the
program.

When you want to access your favorite programs easily and with less clicking in
menus, the favorites list can help. Click on the + Favorites icon and RockWorks will
automatically save the active program to your favorites list. Use the Favorites icon
on the Main RockWorks window to view or edit this list.

Click on the + Playlist icon to quickly add the active program and its settings to your
current playlist, visible in the main RockWorks window on the Playlist tab. View,
edit, and save the Playlists from there also.
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Exercise 4: Create Stratigraphic Models and Diagrams in the
Borehole Manager

In this exercise you will create Stratigraphic models and diagrams using data from the
Borehole Manager.

Step 1: Create a Stratigraphy Model

e On the Borehole Manager tab, click Edit | Enable all Boreholes
e Choose the Stratigraphy | Layered Model menu option.

e Addacheck mark for  Interpolate Surfaces and click on its tab to display the
surface modeling options.

e Turn these items off:
[T Constraining Surface
" Polygon Filter
" Baseplate
[ Volumetrics
[ Save As Solid Model

e Click on the Gridding Method tab.
e Click on Dimensions and select * Based on Project Dimensions.

¢ In the Algorithms section there is a list of several different interpolation methods.
You can get a detailed description of these methods in the RockWorks Help files.
Select the * Inverse Distance method.

¢ In the Options section, turn on / off the following items:
™ Faulted

i Decluster
" Logarithmic
" High-Fidelity

38 RockWorks Training Manual - Exercises



Polyenhance
Densify

Max. Distance
Z = Color

Smoothing

[ I B B

e Click on the Modeling Sequence tab and select * Base-to-Top (Onlap)

e C(Click the Diagram tab on the far-left side and remove the check marks from the
following items:

" Explode
"l Hide Thin Zones

e Be sure that none of the added layers are active:
Striplogs

Draped Image

Floating Image

Perimeter Cage

Legend(s)

Infrastructure

Faults

Other 3D Files

I N B B

e C(Click Continue.
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The program will interpolate grid files for the top and base of each Stratigraphy
Formation to form the Stratigraphic block model and display it in a new RockPlot3D tab.

e Click on the blue Stretch button in the horizontal toolbar at the top so you can get a
better look at the different layers in the model.

e Click the "+" sign to the left of the Stratigraphy Model heading in the Data tree to
the left of the 3D model, to expand the list.

You should now see a list of the Stratigraphy Formations in the model (circled above).

e Click on the "+" sign next to the Spergen Fm. unit and note that the unit is composed
of a Top, Base and Sides, those can be checked on/off to view individually.

Next, let’s regenerate this stratigraphic model, but take advantage of an option that allows
us to better view pinched out and thin units.

e Back in the Options tab at the top of the window, make the following changes:
" Interpolate Surfaces: Uncheck this option. This tells the program to use the
surfaces already created to display the model.

Click on the Diagram tab and add a check mark to the =~ Hide Thin Zones option.
Specify a Thickness Cutoff of 0.5.
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e C(lick Continue.

RockWorks will regenerate the Stratigraphic model using the existing surfaces but now
making thin areas invisible. A new RockPlot3D scene will be displayed.

¢ In the RockPlot data pane, expand the Stratigraphy Model list, and remove the
check marks from the A-Horizon and Spergen Fm. groups to see the pinch out of the
Leadyville Ls.

e Experiment with turning different units on and off.

e Choose File | Save in the RockPlot3D windows and save the 3D scene as
Stratigraphy Model.Rw3D.

e Next, append your lithology logs to this scene by choosing File | Append and
specifying the Lithology logs.Rw3D file you saved earlier. When prompted with the
message Do you want to overwrite the current Stratigraphy, Lithology, and Well
Construction tables?, click on the No button. RockWorks will display the two plots
appended together.

e Close the RockPlot3D Window. You do not need to save the changes you made to the
current Rw3D file.
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Step 2: Create Modeled Stratigraphy Cross-Sections

RockWorks gives users options for creating two types of Stratigraphy sections; straight
line sections, where the program simply draws straight line contacts from hole to hole,

and modeled sections, where the program actually slices through the grid files for each
formation model to create the section. In this step, we’ll create a modeled diagram.

e Choose the Stratigraphy | Section | Model Based menu option.
e In the Main Options tab, the settings on the left should look like this:

e Click on the 2D Striplog Design tab to the right. Check on the following:
W Title

¥ Depths
i Lithology
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[T All of the other Striplog items should be unchecked.

e Click on the Section Location tab at the top of the window.

e A familiar screen showing your last section line should appear. Click the Clear
button to erase the old section, and choose a new section line trending from West to
East across the area. Do not select the boreholes with lines because the wells are not
vertical. The examples shown below were generated from this section line:

.DN—32
.
*h-3a oH-31 o33
—"E .

ot

‘Nﬂ *ohte

.DH-ES

.DH—ﬁﬁ

.BH—1

*ohess

\ .
a1 oheos -3¢ ot

.D 24
/ *otr

DH-14.

oH-21 LI

e C(Click on Continue at the bottom of the window.

A RockPlot2D tab will appear and display your Stratigraphic cross-section. Note that if
you have any deviated boreholes chosen in your sections, your contacts may not match

up with your borehole contacts.
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e Close the Stratigraphic Section window, you do not need to save it.

Step 3: Create a Modeled Stratigraphy Fence Diagram
When you create a modeled fence diagram in RockWorks, the program takes a

stratigraphy model like the one you created in Step 1 and cuts slices through the model
based on the user’s specifications.

e Choose the Stratigraphy | Fence | Model-Based menu option.
e Check on and off the following options:

e Click on the Fence Location tab from the top row of tabs.

You should now see a plan view map of your borings.
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e Uncheck the ' Snap option at the top left of the window if it happens to be on.

e Use your mouse to draw a few fence panels by clicking on the panel endpoint
locations. If you want to start over, click the Clear button.

Y23

X = 481,8569 V = 4,400,114.5

Each panel is composed of two points. Ask your instructor for help if you are not sure
how the fence selection works. Notice that your fence panels do NOT have to go from
well to well.

(Note also that instead of manually drawing the panels, you can choose pre-configured,
regularly-spaced panel layouts by clicking on one of the buttons to the left of the map.)

e When you are satisfied with your selection, click Continue. A new RockPlot3D tab
displays the modeled fence diagram.

e Click on the diagram and drag the mouse to rotate the diagram.

e Choose File | Save to save this 3D Scene as StratigraphyFence.Rw3D
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e Choose View | Lighting and experiment with the lighting options available in the
viewer. When you are done, make sure the Ambient Lighting is checked off. The
vertical Ambient slider bar should be near Low and the Diffuse bar should be near
High. Click the Close button.

e Practice appending other 3D scenes, such as Lithology Logs.Rw3D or Benzene
Logs.Rw3D, to your fence diagram by choosing the File | Append menu.

e Close RockPlot3D. You do not need to save changes made to the current RW3D file.
Step 4: Create 2D Contour Maps of Stratigraphy

The Stratigraphy menu also has tools for viewing structural contour maps and isopach
maps of stratigraphic units.
e Choose Stratigraphy | Structure Grid from the main RockWorks menu.

e Click on the field to the right of Stratigraphic Unit and choose the Spergen Fm.
Verify that the * Superface (Top) option is selected.

e Click the Output Grid tab and type in the grid name: Spergen Structure.RwGrd.

When you are naming this new grid, you may notice that the program has already created
grids defining the top and the base of each unit for the Stratigraphic Model in Step 1. This
new RwGrd file will not affect the grids in the model as long as you choose a different
RwGrd file name.

e Click the Gridding Method item and review, these can be left as they were for the
Stratigraphy Model.

e Checkthe 2D Grid Map item and click the tab to display, review the mapping
parameters.

e Check on and off the following items:
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e Under Peripherals:
¥ Color Legend

¥ North Arrow
¥ Scalebar

e Besure - 3D Grid Diagram is not checked.

e Click Continue to generate the grid model and map.

A RockPlot2D pane displays a map contouring the top of the Spergen Formation.

e C(Click on the color legend item with your mouse and move it to the right. You can
also resize it by clicking, holding, and dragging a corner handle. If you double click
on the legend more options are available.

e Ifitis not currently visible, display the RockPlot Layers pane by clicking the small
"+" button in the upper-right corner of the 2D Map Window.
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e Experiment with removing/inserting check-marks in the different layer names to see
their effect on the display.

e Close this window, you do not need to save the RW2D file.

Extra Credit: Create a Stratigraphy Isopach Map using Custom Colors

e Choose the Stratigraphy | 2-D Isopach Map option from the main RockWorks
menu.

e Set the Superface (Top) of Isopach to the Potosi Fm and select
* Use Top of Stratigraphic Unit.

o Set the Subface (Base) of Isopach to the same Potosi Fm and select
¥ Use Base of Stratigraphic Unit.

Most of the other settings will be maintained, but let's change the labels displayed in the
point map.

e C(lickonthe 2D Grid Map tab. Be sure the =~ Map Overlays layer is activated,
and  Borehole Locations.

e Establish these settings:
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e C(Click Continue at the bottom of the window.

The resulting map should look similar to
the one to the right.

Next, let’s create a custom color table so
that the map can be displayed using a
different color scheme.

First, note that the thickness of the
Potosi Formation ranges from close to 0,
to around 45m.

e Click the upper-left Options tab to return to the program settings.

e Click on 2D Grid Map tab, then click on Colored Intervals.

e Under Scheme you will see several color options. Click in the button next to
 Custom, and then click the Edit button to the right.

A listing of all of the existing color tables in the current database will be shown. For this

map, we'll create a new one.

e C(Click on the New Table button, and enter a name for this table: Potosi Isopach, and
click OK.
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A Color Fill Table is used to define a listing of value intervals and their corresponding
colors, to be used by the program when building 2D or 3D color-filled contour maps,
solid models, and striplogs. This window permits you to enter the Order, Minimum,
Maximum, and Color manually, or use the Palette button in the next step to fill the table
automatically. You may list as many value intervals and colors as you wish. You may
declare uneven and discontinuous intervals.

e C(Click on the Palette button.

¢ In the Palettes window, type in a Minimum of 0, a Maximum of 45, and an
Increment of 5.

e Experiment with the different Color Schemes (click on the OK button to see what
the different color schemes look like in the color table). An example is shown here.

¢ Once you have found one you are happy with, click the Exit button to close the table.

e Back at the Color Table selection window, click on the name of the table you just
created: Potosi Isopach, and click OK.

e Once you are back in the isopach map window, click on the Continue button to
recreate the isopach map with the new colors.

If you have additional time, you can experiment with other mapping options, we
recommend that you take a look at the different Contour Line options for creating maps.

e When you are done, close the map window; you don’t need to save the map.

50 RockWorks Training Manual - Exercises



Exercise 5: Create Lithology Solid Models and Diagrams in
the Borehole Manager

The Lithology exercises demonstrate the use of RockWorks 3D solid models with the
algorithms for data based on discrete classifications. Compare these algorithms with
those used for continuously-variable data in the [-Data, P-Data, and T-Data menus.

Step 1: Create a Lithology Model

e Under the Lithology menu, choose Lithology | Solid.

e With Model selected on the left side, choose * Create New Model. Click Solid to
be Created, then in the prompt to the right, name the model Lithologyl.RwMod.

e Below in this list, click Algorithm. Use these settings to define the modeling method.

@ Lateral Blending: Choose this option
to randomize the horizontal contacts in the
middle third distance between boreholes.

v

Interpolate Outliers: Check this
option.

e Check on and off the following items to the right of Special Options:

-

M

<l

-
-
-

Decluster

Smoothing

Polygon

Superface: Check this.

@ Automatic (Based on borehole surface elevations) — This option hides the
interpolated nodes above the top of the boreholes. RockWorks will create a grid
model representing the elevation at the borehole tops (the ground surface) and set
to "null" all model nodes above that. Note: In a later lesson, you'll use the
"Manual" filter, selecting an existing grid model.

Subface: Check this.
2/ Automatic (Based on maximum borehole depths) — This hides the
interpolated nodes that lie below the base of the boreholes. As above, RockWorks

will automatically create a grid surface for the borehole base elevations and hide
lithology nodes that lie below.

Tilting
Warping
Faulted

¢ Be sure these options under Create New Model are not checked:

-
-

Limit Input
Limit Output
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e Insertacheckin 3D Solid Diagram and click on the tab. Check on and off these
items:

v

Y I B

[ -

Include Volumetrics

Striplogs

Draped Image

Floating Image

Perimeter Cage

Legend(s) — Click here to select Lithology
Infrastructure

Faults

Other 3D Files

e C(Click Continue at the bottom of the window.

A new tab is created containing a RockPlot3D window with the lithology block model.
Notice that there are three items listed in the Data portion of the tree on the left side of
the screen; a Lithology Model, Lithology Model Volumetrics and a Perimeter Cage.

e View the items under Lithology Model Volumetrics by clicking on the "+" sign to
the left. Notice that each material in your Lithology Types table is listed, along with
their G-values, volumes and masses (masses are generated using the densities listed in
the Lithology Types table).

e Double click on the Lithology Model item located in the data tree to display the
RockPlot3D Options dialog box.

52
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RockPlot3D Options B
Solid Model Options - Lithology Model - Volume = 3,428,025.0
Fill

Color Scheme

Lithology Table ~

Draw Style Opacity Smoathing

Voxels ~ +  Smooth ~
-

[Jrlot Outline [JPlat voxel Outline

IV Filter

LOW \I 1 1 1 'I 1 1 1 1 1 1

H|gh | | | | 1 1 1 1 1 I
1.00 .00

Show Volume 3.428,025.0

Slices
® Horizontal O North-south O East-West

Wire Frame and e i Add Slice | 1650.0000

Efinfo | X Close || ? Help
The total volume for the model is displayed below the Filter Low High options.
e Check on the ¥ Filter checkbox to enable the filtering tool.

e Set the lower limit to 4 and the upper limit to S so that you are isolating all of the
voxels that represent Sand and Gravel. The Show Volume value changes
immediately.

e Click on the Apply button, then the Close button.

The solid model you are viewing in RockPlot3D changes to show only the Sand and
Gravel units.

e Save this scene by choosing File | Save. Name this scene Lithology Model.rw3d.

e Close the menu by clicking on the "X" button in the upper right-hand corner.
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Step 2: Create a Lithology Fence Diagram

When Lithology fence diagrams, profiles and sections are created in RockWorks, the
program takes one slice or multiple slices through a solid model that has already been
created, or that is created at the same time as the diagram. Because we have already
created a Lithology model in Step 1, we are going to now use that model to display some
additional diagrams.

e Choose the Lithology | Fence menu option.

e With Model selected along the left, choose ™ Use Existing Model and browse for
the Lithologyl.rwmod file that was created in the previous step.

e Check on and off the following Diagram Options:

e Click on the 3D Log Design tab along the top row of options.

e In the log designer check items:
W Title
W Axis
i Lithology
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All other Striplog items should be checked off.

e Click on the Fence Location tab to the right. You should see the fence panels you
used in the last exercise.

e FErase the panels by clicking the Clear button in the toolbar above the map. This time,
let’s have the program draw fence panels for us.

e Uncheck the "/ Snap option at the top, so that the panels are not forced to the
borehole locations.

e C(Click on the Hatch button in the toolbar to the left.

The program will automatically draw several evenly-spaced panels trending in the North-
West/South-East and the North-East/South-West directions.

e C(Click Continue at the bottom of the window.

A new RockPlot3D tab is displayed.

¢ Expand the Lithology Fence item in the data tree on the left and experiment with
turning different panels on and off.

e Save the fence diagram as Lithology fence.Rw3D and close the window.

RockWorks Training Manual 55



Extra Credit: Experiment with the different Lithology modeling options

e Next, let’s create a new Lithology RwMod file, and experiment with the various
options that can be checked on and off during the modeling process.

e Choose Lithology | Section, and select * Create New Model.

e Name the new Lithology model Lithology2.RwMod.

e C(Click the Algorithm button below in the list, and set the algorithm to: Lateral
Extrusion

e Select the section line that you would like to create in the Section Location tab.

e C(lick Continue.

The resulting section displays blocky transitions between boreholes. The boundaries
between lithology units are more abrupt because the Lateral Extrusion method does not
randomize the middle third of the area between boreholes.

If you have additional time, we would suggest that you experiment with other options and
menus.
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Exercise 6: Create |-Data and P-Data Solid Models and
Diagrams using the Borehole Manager

The I-Data (Interval Data) and P-Data (Point Data) exercises illustrate the solid modeling
algorithms used with continuously variable data.

Step 1: Create a Solid Model based on Interval-Data

e Choose I-Data | Solid from the menu bar at the top of the main RockWorks window.

e Under Model, choose * Create New Model. Type in the name for the model to be
interpolated: Benzene01.RwMod

e Click on I-Data Track and specify Benzene Soil as the data to be modeled. Be sure
these are not checked:

[ Save Points to File
[T G-Value Filter
[ Resample

e Click on Algorithm and choose * IDW-Anisotropic.

This method uses Inverse Distance interpolation, but only uses the closest eight control
points when computing a value for each voxel. You can find a detailed explanation of the
interpolation methods available in the RockWorks Help file.

e Click on Special Options and the items listed below are turned on and off as shown:

<]

Decluster

<l

Smoothing
Cutoff-H
Cutoft-V
Logarithm
HiFi

Distance

A 0OM0n0

Polygon

<

Superface (this should be set to Automatic)
Subface (this should be set to Automatic as well)

<l

Tilting
Warping
Faulted
G=Color

Dimensions: Should be * Based on Project Dimensions
Undefined: Should be * Null

I I R
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| Create 3D Diagram: Click here to be sure this is checked and to access the
diagram settings.

Set Block Diagram to * Isosurface.
" Isomesh should not be checked.
™ Filter should be off.

Click Color Scheme and choose the Cold to Hot option.
Verify that the following diagram options are not selected:
Striplogs

Drape Image

Floating Image

Perimeter Cage

Legends

Infrastructure

Faults

Other 3D Files

I O O o B

Click on Output Options to be sure these settings are displayed:
¥ Display

" Save

" Export

Click Continue at the bottom of the window to proceed. RockWorks will interpolate
the solid model and generate an isosurface diagram. It will be displayed on a new,
untitled RockPlot3D tab.
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Notice that in the data tree on the left side of the page, there is a Benzene Soil Model

listed under "Data".

e Add exaggeration to your model so that you can see it more clearly by clicking the

Stretch button (circled in the previous diagram) or by choosing View | Dimensions.

e Double click on Benzene Soil

e Append this scene and the
benzene logs scene that we
created in a previous exercise
by selecting File | Append
and choosing Benzene logs
rw3d. Answer No when
prompted "Do you want to
overwrite the current
Stratigraphy, Lithology and
Well Construction tables?".

e C(Close the current window. Do
not save the changes to your
RW3D file.
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in the data tree to display the Isosurface Options.

Adjust the Iso-level value to 30 by
using the slider bar or typing it into
the Iso-Level Value prompt and
click Apply.

Notice that the Volume value changes
as you adjust the Iso-Level. The
program is automatically calculating
volume of displayed material.

Experiment with changing the
Color Scheme of your model.

Try changing the Contours option
to show where the isosurface is
truncated by the superface grid.

Assign the model an Opacity value
of 70.

Click on the Apply button and then
Close.

Select File | Save to save the scene
as Benzene model.rw3d.
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Step 2: Create an |-Data Profile

60

Select I-Data | Profile from the menu bar at the top of the main RockWorks window.
The Vertical Exaggeration Factor can be left at 1.

Click Model and select ™ Use Existing Model.
Click on the yellow folder to the right of the file name to browse for the
Benzene01.RwMod file you just created.

Click Contours and set these options:
[ Contour Lines

¥ Colored Intervals: Choose the © 2-Colors (Min -> Max) color scheme.

Check on and off the following diagram settings:

<l

Striplogs

<]

Annotation
Surface Profile
Faults

Parallel Profiles
Infrastructure
Other 2D Files

Peripherals, click here and turn on the Color Legend. Adjust the location of the
legend in the preview area.

Border

I I B B R

<l

m

Click on Output Options to be sure these settings are shown:

¥  Display

[ Save

" Export

Click on the Profile Location Map tab at the top of the window. The section line you
choose in Exercise 2 should be displayed in the window. Choose a profile line that

goes through the center of the plume (use the image below as a guide), and make the
profile swath = 15m.
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e C(Click Continue.

A 2D Profile should open in a new RockPlot2D tab.

e Select File | Save to save your profile diagram as Benzene profile. Rw2D.

e Click on the "X" button on the upper tab to close the RockPlot2D window.
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Step 3: Create a Solid Model Based on Point-Data

This portion of the exercise works with point-based data and the P-Data menu and table.

62

Choose P-Data | Solid from the main RockWorks window.

Under Model, choose ® Create New Model

Type in the name for the model to be interpolated: Gamma.RwMod
Click on P-Data Track and select Gamma as the data to be modeled.
¥ Create 3D Diagram: Click here to access the diagram settings.

Set Block Diagram to * Voxels and choose Full Voxel.

Verify that the following diagram options are on/off:

<]

Striplogs
Drape Image
Floating Image

Perimeter Cage

Y I R

Legends: Click here to select Color only.
Infrastructure

Faults

Other 3D Files

[ -

Click on Output Options to be sure these settings are displayed:

W Display

[ Save

" Export

Click on 3D Log Design at the top of the window.

Uncheck I Lithology and check on ¥ P-Data #1 in the visible items listing.

In the P-Data #1 Options to the right, be sure the Track is set to Gamma. The
remaining default settings should be fine.

Click Continue to proceed with model generation.
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Gamma
100.0
I 80.0
80.0
70.0
60.0
50.0
40.0
30.0
200
10.0
0.0

A new RockPlot3D tab displays the block model. Notice that this model looks a little
different that the Benzene model we viewed earlier. This is because the All Voxels option
was chosen when the view was created. You can filter out certain values in a Gamma
Model in a similar manner that you created the isosurface in Step 1.

e Double click on the Gamma icon  in the data pane to display the Solid Model
Options - Gamma settings.

Notice that this looks a little different than the previous options window you used. One
difference is that you can filter values from above or below. This tool can be used to
isolate both high and low values.

e Add a check mark to the ¥ Filter option.

e Use the slider bar to make the High threshold for your filter around 80. Notice that
the displayed volume changes as you move the slider bar. Click Apply then Close to
enforce this change in the diagram.

e Click File | Save to save your 3D view as Gamma Model.rw3d.
e Close this window. E
Step 4: Create a Fence Diagram of a P-Data Model

e Select P-Data | Fence.
e Choose ™ Use Existing Model. Browse for the Gamma.RwMod solid model.

e Check on and off the following diagram items:
" Panel Borders

"l Surface Profiles
¥ Striplogs
" Draped Image
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Floating Image

KU

Perimeter Cage

<]

Legends: Choose the Color legend.
Infrastructure

Faults

Other 3D Files

[ -

e C(Click on the Fence Location tab at the top of the window.
e Click the Clear button.

e Either draw in your fence panels by hand, or use the toolbar buttons to choose a set of
predefined panels.

e Besure - Location Map, at the top of the window, is turned off
e Click Continue. A new RockPlot3D tab displays the Gamma fence diagram.
e Experiment with stretching and rotating the diagram.

e Expand the Gamma Fence item in the data tree and turn panels on and off with the
check boxes for the panels labeled with XY coordinates.

e Save your fence diagram as Gamma Fence.rw3d.

e Append your lithology logs to the fence diagram by choosing File | Append. Specify
the file Lithology Logs.Rw3D saved in the Lithology exercise. Click Yes to Do you
want to overwrite the current Stratigraphy, Lithology, and Well Construction tables.

Notice that there are now two sets of overlapping logs being displayed, and two
overlapping legends on the left side of the window. You can fix this using the following
steps.

e Turn off the Gamma logs by unchecking the first [ Logs item in the data tree (you
may have to experiment to determine which "Logs" item is which).

e Click the "+" button to the left of Legends in the data tree to expand the list.
Notice that both legends are listed. You can turn them on and off using the check boxes.

We are going to shift the Lithology legend up and the Gamma legend down so that they
do not overlap.
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e Double click on the Lithology legend icon. A
RockPlot3D options window should appear.

e Change the Vertical Offset to 0.5.

e Click Apply.

The Lithology Legend moves upwards towards the
top of the page in the RockPlot3D window.

Notice that you can also change Legend location,
size, font style, etc. in this window.

e C(Click the Close button.

e Now, double click on the Gamma legend item.

e This time, change the offset value to -0.3. Adjust the location from the Left Side to
the Right Side using the pull down tool.

e Remove the check-mark from “~ Outline Legend
e Set the Decimals to 0
e Click Apply

e Close the current window. You do not need to save the changes you have made.
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Extra Credit: Use a Custom Color Table to View a Benzene Model

The color schemes that are automatically assigned by the Borehole Manager do not work
well for certain datasets. When this happens, it may be necessary to create custom Color
Fill or Contour tables to use for visualization. Custom tables allow the user to visualize
data and models using logarithmic or irregularly spaced intervals. Here, we’ll have you
create a custom color table for Benzene values, and use it to view an [-Data profile, fence
diagram and 3D striplogs.

e Access the Project Manager by clicking on its tab in the main RockWorks program
window.

e Click the arrow at the left of the Project Tables heading to expand the list.

e Expand the Map/Model Tables category by clicking on the arrow on the left.
e Right-click on Color Fill Table, and select Add a Color Fill Table.

e Type in the name: Benzene Colors and click OK. You'll see a blank table.

e Add values and colors similar to the ones shown below, or use the Palette icon on the
left to create your own color scheme ranging from 0 to 1000 with an increment of
250. Change the Minimum and Maximum for each interval to match the values in
the screen shot below. Click Exit when done. The table values are saved in the
database automatically.

We will use this new color table to create a two-dimensional view of the
Benzene01.RwMod file created earlier in this exercise.

e Back at the main program window, choose I-Data | Section | Model-Based.

e Click Model, choose ™ Use Existing Model, and select the Benzene01.RwMod file.

e Click Contours and be sure Colored Intervals is checked. Set the color scheme
to ® Custom. Click Edit to the right and select the Benzene Colors table that you
created. Click OK to close.

e Be sure these other diagram layers are on/off, using the same settings as the I-Data
Profile earlier in this lesson.

¥ Striplogs
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<l

Annotation

Surface Profile

Faults

Parallel Profiles
Infrastructure

Other 2D Files
Peripherals, Color Legend
Border

U I R R

-

e Click 2D Log Design at the top of the window. Turn the following items on/off:
W Title
¥ Depths
¥ I-Data #1. Under Bargraph Options to the right, click Fill Options and select
' Table Based, choosing the Benzene Colors table.
" Turn off any other log columns (Lithology, P-Data, etc.)

e Click on Section Location. You should see the last section line you drew. You can
accept this line, or draw a new line as you wish (click Clear to clear the display as
needed).

e When you are ready to create the diagram, click Continue at the bottom of the
window.
The resulting diagram should use the new color scheme to display the diagram.

¢ Once you are finished experimenting with this tool, you can close the window. You
do not need to save the image.

e Next, choose I-Data | Fence from the main program window.

e Click Model and select * Use Existing Model, and select the file
Benzene01.RwMod.

e C(Click Color Scheme and choose Custom. Click Edit and select Benzene Colors.
Click OK to close the window.

e Check on and off the following items; these should still be default from the previous
fence diagram:

Panel Borders

Surface Profiles

Y

Striplogs
Draped Image

a M

Floating Image

<l

Perimeter Cage
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¥ Legends: Choose the Color legend.
[ Infrastructure

" Faults

"1 Other 3D Files

e Click on 3D Log Design at the top of the window. Check on the following items.
Check all other items off.

W Title

¥ Depths

¥ I-Data #1. Under I-Data #1 Options to the right, set the Track to Benzene Soil.
Set Appearance to " Taple Based, choosing the Benzene Colors table.

e Click on Fence Location. Click Clear, and uncheck [’ Snap. Click Horizontals
button to draw automatic panels from the west to the east.

e When you are ready to proceed, click Continue at the bottom of the window.

In the resulting diagram, your 3D logs and fence panels are using the color scheme
specified in the color fill table.
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Exercise 7: Working with Water Levels and T-Data in the
Borehole Manager

In this exercise, we’ll create a T-Data model constrained by a Water Level Surface at the
top, and Bedrock Surface at the bottom.

Step 1: Create a Water Level Grid

First, we’ll need to create the Water Level grid model (RwGrd file). We will be creating
models for the date 2/14/2017.

In the main Borehole Manager window, click on DH-01, then click on the Water
Levels tab. Note that there are two aquifers, and water level depths from several
different dates.

Choose Aquifers | Plan Map from the main menu.

Starting at the top of the window, click the Time Filter tab. Be sure the  Time
Filter is checked, and choose Exact. Specify the date 2/14/2017.

Click back to the Main Options tab.
Click Aquifer and select Aquifer 1 as the aquifer to be modeled.

Click Map Type and choose « Superface (Top) Elevations.
Check 2D Grid Map and click on the tab to establish the mapping options.

Be sure these grid map layers are on/off:
¥ Colored Intervals: Set this to a Min — Max color scheme. Click on the large
color bar to the right and choose one of the displayed schemes.

" Contour Lines
[ Labeled Cells
" Gradient Vectors
Turn these added map layers on/off.
[ Background Image
¥ Labeled Axes
¥ Map Overlays. Be sure  Borehole Locations is selected, with these layers
on/off.
¥ Symbols
" Borehole IDs
¥ Aquifer Data. Establish these settings:
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The other Map Overlays can be turned off.
" Other 2D Files

" Peripherals
[ Border

Click Continue to proceed.

The program will interpolate a grid model for the groundwater elevations for the
specified date. It will create a color-contoured map representing those elevations, with
symbols and labels.

If you use the Project Manager to view the list of Grid Models in your project, you
should see three new RwGrd files for Aquifer 1 named with the 2 14 17 date:
Aquifer 1 2 14 2017 base.RwGrd

Aquifer 1 2 14 2017 isopach.RwGrd

Aquifer 1 2 14 2017 top. RwGrd. This is the grid model to be used in the Superface
map.

Close the map window. You do not need to save.

Step 2: Create T-Data Model

Next, let’s create a new T-Data solid model and filter it with the new grid and the
Basement_Top stratigraphic grid.

70

Choose T-Data | Solid from the main menu.
The  Time Filter should still be activated for 2/14/2017, at the top of the window.

In the Main Options, make sure that (¥ Create New Model is selected.
Solid to be Created: Type in: Arsenic 2 14 17.RwMod
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e T-Data Track: Choose Arsenic.
e Click Algorithm and select:

* IDW - Advanced

For the Weighting Exponents, specify a Horizontal as 2.0, and a Vertical as
5.0.

0 Set Search Method to All Points.

e Click Special Options and establish these settings:
¥ Superface: Set this to Manual and browse for the Aquifer
1 2 14 2017_top.RwGrd file.

¥ Subface: Set this to Manual and browse for the Basement_Top.RwGrd file.
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e Besure Create 3D Diagram is checked.

e Establish these diagram settings:

0 Block Diagram: Choose {* All Voxels and ** Full Voxel
0 Color Scheme: Choose Min -> Max.

o Establish these additional layer settings:
[T Striplogs

Draped Image

Floating Image

Perimeter Cage

A OM0n

Legends should be on, choose Color
Infrastructure

Faults

"7 Other 3D Files

a M

e Click Continue to proceed.

In the resulting RockPlot3D tab, experiment with the different viewing options available
for the model. To see the viewing options, double click on the Arsenic Model item in the
data tree on the left side of the window. Once you are done with this, you can close the
plot window. You do not need to save the Rw3D file.

Extra Credit: Create contour maps of T-Data

In this step, we’ll create a 2D contour map of T-Data for a specific parameter and date,
and we’ll also experiment with the effects of "Logarithmic" interpolation.

First, we’ll create a histogram showing measured values for Arsenic on 2/14/2017.

e Back at the main program window select T-Data | Histogram.
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0 Make sure that the T-Data Track is set to Arsenic.

0 The  Time Filter at the top of the window should still be enabled.

e C(Click Continue.

In the resulting diagram, note that the majority of T-Data measurements fall below a
value of 100 or so, with only 1 or 2 measurements above 100.

Histogram
Linear Scaling
Mean W18D M28D IRt
(183 iyt 1382

3.-:3-_JI m_m [

500 100.0 150.0 2000 255.0 a0 0.0 000"

For datasets such as this (that range over multiple orders of magnitude), the
"Logarithmic" interpolation method may come in handy.

To demonstrate how, let’s create some 2D contour maps of Arsenic for this date.

e Close the T-Data Histogram window. You do not need to save the diagram.
e Back at the main program window, select T-Data | Statistics Map.

e Based on the last few steps, the T-Data Track should be set to Arsenic, and the
Time Filter should be set to Exact and 2/14/2017.

e For Map Type, select Z = Highest Value. If there is more than one measurement for
a well (for example, if you have more than one screened interval), the program will
use the highest value when interpolating the 2D grid file.

e Name the Output Grid: Arsenic_2_14_17.RwGrd.

e Click on Gridding Method and set the Algorithm to " Inverse Distance. Under
Options, turn on ~ Decluster only.

. 2D Grid Map should be checked with these layers activated.
¥ Colored Intervals

¥ Contour Lines
¥ Labeled Axes
¥ Map Overlays
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¥ Borehole Locations: Turn off | Aquifer Data. Turnon ~ T-Data, to plot
only Arsenic values for the 2/14/2017 date. Click Label Options and set the
Size to 1. We’ll let you figure out the exact steps for this yourself, but if you
have any questions about how to do this, just ask the instructor.

¥ Peripherals, be sure that the Color Legend, Scalebar and North Arrow are
checked on.

e ' 3D Grid Map should be unchecked.

e Click Continue to proceed.

The resulting map will look something like the following.

e Go back to the Options tab to the left, where you will create another model and map.
e Return to Gridding Method | Options and activate the ~ Logarithmic option.
¢ For Output Grid, enter the name: Arsenic_2 14 _17 log.RwGrd

e Click Continue to create the new grid model and map.

The resulting diagram should look like the map that follows. The plume still has the same
general shape, but the effects of the high value have been isolated.
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See the RockWorks Help files for an explanation of what the program does when the
Logarithmic interpolation option is selected.

e Ifyou have time left, you may wish to experiment with the Logarithmic options when
interpolating a solid model through the I-Data, T-Data or P-Data menus.

e Close the maps when finished. There is no need to save the maps from this exercise.
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Exercise 8: Introduction to the RockWorks Utilities — The
Map Menu

This exercise will talk you through some of the map options available in the RockWorks
Utilities.

Step 1: Open an RwDat file to the Datasheet

e Expand the Datasheet Files heading in the Project Manager pane.
e Double-click on the Hydrochem_All.RwDat file to open it. RwDat is the extension
used for files saved in the datasheet.

Step 2: Adjust Column Widths in the RockWorks Datasheet

This Hydrochemistry datasheet shows well IDs, location information, and different ion
concentrations in ppm (parts per million). First, let’s experiment with changing column
appearances and column data types.

e You may notice that the X and Y columns are a little wider than they need to be. You
can adjust column width with your mouse by clicking on the column divider lines and
moving them to the right or left. Decrease the widths for the X and Y columns so that
you can more easily view additional data columns.

e The View | Optimize Column Widths menu command can also be used to adjust the
columns.

-+

Step 3: Change Column Name and Data Type

In this datasheet, let’s change the X and Y column titles to Easting and Northing
(respectively).

e Right click on the column header cell labeled “X” and select the Column Properties
option, this will open a menu at the right side of the window.
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e Change the titles for Columns 3 and 4 to Easting and Northing.

e Be sure the Content Type is set to X or Y and the Coordinate Units to UTM
Meters.

e Use the Previous or Next green arrow buttons to advance/backtrack to the column
you wish to modify.

Your edits will be show in the datasheet to the left.
Step 4: Create Point Maps

In this step, we’ll use the Point Symbols menu item to create a map showing well
locations and concentration information from groundwater samples.

e In the Utilities portion of the icon menu at the top of the main RockWorks window,
choose the Maps | Point Symbols option.

e Under Main Options | Symbol Options | XY Columns, choose columns for the
Easting and Northing locations that you just defined.

e Under Symbols, set the source to ~ Column Based and choose the column named
Symbol. Set the Dimensions to Uniform at a size of 1.
The other symbol styles (Uniform, Circles, etc.) can be unchecked.
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Click on  Symbol Labels. This window will show all of the varied settings you can
use to customize your point map labels.

Under Content:

(0}

(0}
(0}
(0}

Turn on the ¥ Northeast label
Set the Data Column to ID.
Set the Text Color to Black.

¥ Add a check mark to the Fill Bkgnd. column and set the Background
Color to yellow.

Enter the Prefix: Well ID:

Turn on the ™ Southeast label, and select one of the cation columns such as
Ca. Assign an opaque Background Color of your choice and type in a Prefix
for the concentration label that will be plotted. For example, for Calcium, you
could enter: Ca:

Turn on the ™ Southwest label, selecting a different cation column. Choose a
background color, and type in a label Prefix.

Turn on the ™ Northwest label, selecting another cation column and
background color, and type in a Prefix for the label.

Click on Leader Lines and view the options, the default is okay for now.

On the Orientation tab, choose Horizontal for display of the labels.

Click on the Dimensions tab and make sure the ¥ Automatic Offset option is
checked on.

Turn off all of the additional map layers: Background Image - Border.

Click the Continue button to create the map.
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You should get a map that looks similar to this one:
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Next, let’s recreate this map with just a single label, and without the opaque backgrounds
for the text.

e Back on the Options tab in the upper left of this window, click on the Symbol
Options tab again.

0 Click on the Symbol Labels tab and under Content, turn off all of the labels
except the ¥ Northeast label.

Turn off the [ Fill Bkgnd. for this label.

Click on the Leader Lines item and choose the option without the label
border.

e Click Continue to recreate the map.
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You should now have an image that looks similar to this:

Let’s take this map into RockPlot3D so that we can view it with one of the models
created previously.

e To do this, choose the File | Export | RockPlot/3D menu command.

0 Choose to ™ Float the image at an elevation of 1770.

0 At the top of this window uncheck [ Omit Text Altogether.

0 Uncheck all of the other map layers: Striplogs = Other 3D Files.
¢ Click Continue to display the map in a new RockPlot3D window.

e Append your Stratigraphy model to the map by choosing the File | Append menu in
RockPlot3D. There is no need to save the existing plot.

0 Choose the Stratigraphy Model.Rw3D file and click Open to display the
Confirm dialog box.

0 Click Yes to overwrite the current Stratigraphy, Lithology, and Well
Construction tables.

Your model will display right under your map. This is a way to view data from
RockPlot2D in the 3D Viewer.

e Close RockPlot3D. You do not need to save your Rw3D file.

e Save your RockPlot2D map as Hydrochem.Rw2D. Once you’ve saved the map,
close RockPlot2D.

Step 5: Create a Grid-Based Map

In this step of the exercise, we’ll create contours based on RwGrd models similar to those
created for stratigraphic surfaces in the Borehole Manager. Let’s create a map showing
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Sodium concentrations in the area.

Choose the ModOps | Grid | Create | XYZ = Grid menu option.

e Under Grid Model | Data Source, choose {* Datasheet and make sure that the
Easting and Northing columns are chosen. Set the Z (Elevation) column to: Na

e Select Grid File and enter the output file name: Na.RwGrd. Upper and lower case

letters can be used for the file name, but are not required.

e Under Algorithm, choose ™ Inverse Distance and be sure that [~ Sector-Based

Searching is left unchecked.

e Check the ¥ Create 2-Dimensional Grid Diagram item. Check on and off the

following diagram options:
[ Colored Intervals

<l

Contour Lines
Labeled Cells
Gradient Vectors
Background Image
Labeled Axes

M Omnn

<l

Other 2D Files
Peripherals
Border

[ I

e Uncheck the ! 3D Grid Diagram option.

e C(Click Continue.

You should get a contour map that looks similar to this:

RockWorks Training Manual
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Narthing (F 22t)

e Save your contour map as Sodium Contours.Rw2D and close the map window.

Step 6: Create a Pie Chart Map.

Under the Utilities grouping at the top of the main window, choose Maps |
Piecharts.

Under the Input Columns, make sure that the Easting and Northing columns are
mapped appropriately.

Click on the Components tab to display the multivariate options.
0 Check on the options to W Plot #2 through #5.

0 Assign the Data Column and Color for each component.

#2: Na
#3: K

#4: Ca
#5: Mg

0 Check on the ¥ Explode option for #1.
e Click the Diagram Options tab and Dimensions.
Choose ™ Fixed tab and set the Size to 2.00.
At the bottom of the dialog, change the Inner Radius to 1.00.

Turn on ¥ Labels, and note the available options for label Orientation, Font,
and Offset.

e Tumon  Automatic-Offset (on the left side) and view the available settings.
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e Establish the additional layers settings:
Background Image

Labeled Axes
Map Overlays
Other 2D Files
Peripherals
Border

KU

anamnn

e Click Continue to generate the map.

The resulting map should look similar to this:
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e Save your map as: Pie chart map.Rw2D and close the RockPlot2D Window.
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Extra Credit: Creating Piper and Stiff Diagrams in the RockWorks Utilities

In the Utilities menu grouping, choose HydroChem | Piper.

Confirm that the Input Columns are correct. For example, the Sample ID input
should be set to the column labeled ID.

Verify that the Cations and Anions are assigned correctly.

Click on Diagram Options, explore the different options for plotting TDS Circles
(Total Dissolved Solids), Dividers, Titles, Labels, etc.

Click Continue to display the Piper diagram in a new tab. You may wish to
experiment with other options before you continue on to the Stiff diagram.

Once you are done, you can close the RockPlot2D window, without saving the Rw2D
file.

Next, choose HydroChem | Stiff.
Again, confirm that your input columns are lined up correctly.

Explore the different Diagram Options. Set the Page Layout | Polygons Per Page
setting to 15 so that all of the samples will fit in a single diagram.

Click Continue to create the Stiff diagram.

If you have additional time, you should also experiment with the Durov Diagram and
Stiff Map options under the HydroChem menu.
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Exercise 9: Grid and Solid Model Tools

This exercise will introduce you to the Grid and Solid menus in the MopOps tools.

Step 1: Use Grid Math to Create an Isopach Grid

Under the ModOps tools, choose Grid | Math | Grid & Grid.

e Choose Leadyville Ls. Top.RwGrd for Grid A and Leadville Ls. Base.RwGrd for
Grid B.

e Name the Output grid (Grid C): Leadville Ls_Isopach.RwGrd.
e Set the Operation to Subtract (C=A-B)
e Set the Null Value Handling Options to Result Always Null.

e Check ™ 2D Grid Map. When the tab is selected, the display options should be
displayed to the right. Check on and off the following diagram items:

¥ Colored Intervals — Also, be sure that ¥ Confirm Intervals is checked on.
Contour Lines

Labeled Cells

Gradient Vectors

Background Image

Labeled Axes

Map Overlays

Other 2D Files

Peripherals

¥ Be sure that the Color Legend, Scalebar and North Arrow are checked on.
Border

OO oOon0onn

A
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e Uncheck ! 3D Grid Diagram.
e Click on the Continue button, when prompted, specify a color contour interval of 0.5.
You should see a new RockPlot2D

tab with an image that looks similar to
map to the right.

Step 2: Determine the Volume of the Leadville Ls Formation

Next, we’ll create a statistical report of the thickness grid created in Step 1. Keep the map
that was created in Step 1 open, as we’ll need to take a closer look later.

e Select Grid | Statistics | Stats — Single Grid.

e For the Input grid, choose Leadyville Ls_Isopach.RwGrd.

e Under the Output Options tab, make sure that the RwDat option is selected.
e Click the Continue button.
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The report will list several different types
of information about your grid. What is
the ““Model Volume™ for the grid?

This is the estimated volume (m?®) of the
Leadville Ls unit.

Review the other types of information
provided in the report.

In the real world, your initial models may not always look like you think they should. If
you take a closer look at your Stratigraphy data, you’ll notice that the Leadville
Limestone should really pinch out completely on the west side of the project. One way to
make sure that the unit pinches out properly is to edit the isopach grid and use the new
isopach grid to create new surfaces for the unit.

e  When you are done reviewing the report, close the window.

Step 3: Isolate Highs and Lows in a Grid

e Return to the Grid & Grid Math window, so that you can take a closer look at the
isopach map created in Step 1.

e Ifyou need to make the color legend larger to read the labels, click on the legend, and
drag one of the corner handles so that the legend becomes bigger.
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Let’s assume that that contour line defining the 3 m thickness interval should be the
cutoff for the unit. Everything outside of that area should really have a thickness of 0.

We’ll use the Grid | Filters menu to reassign the grid model values based on this cutoff.

Close this window. You don't need to save the map.
Select Grid | Filters | Hi/Lo Filter.
Set the Input Grid to: Leadville Ls_Isopach.RwGrd

Name the Output Grid: Leadville Ls_Isopach_Filtered. RwGrd.

e Under the Filter Options tab, check on ¥ Replace Values < and enter a value of 3.
e Choose the * Other replacement option and enter a value of 0.

e Make sure to uncheck the I Replace Values > option.

e C(Click on the Continue button, and set the Contour Interval to 0.5.
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Your resulting isopach model should look like this. Close the window after reviewing the
new contour map.

Step 4: Use the Grid Editor to Edit Your Isopach Grid

You may notice that your new isopach map for the Leadville Ls formation may not be
totally realistic. While its does pinch out in the correct spots, the unit pinches out very
quickly, from a thickness of 3 m. to a thickness of 0 m. Let’s use the Grid Editor to
smooth this contact.

Select Grid | Edit to display the Grid Editor window.

In the Grid Editor, click the Open button and choose the Leadville
Ls_Isopach_Filtered.rwgrd file.

Note that you have a smoothing filtered window of 3x3 specified. To activate the
smoothing filter, click on the Smooth button at the top of the window.

Drag the mouse along the contact to start smoothing out the node values along the
edges of the unit. You may need to increase the size of your smoothing window.

If you have time, experiment with the other tools in the Grid Editor.
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As you make changes to your grid, use the contour button at the top of the screen to
preview what your contours will looks like. Once you’ve finished, save your new .RwGrd
file by clicking the Save As button. Name your new grid Leadville
Ls_Isopach_Edited.rwgrd. Once you’ve saved the modified grid, close the Grid Editor.

Step 5: View a Polygon Table

At some point, you may need to assign grid nodes inside or outside of an area (such as a
property line, excavation pit, etc.) a value of zero, or some other number. In this step,
we’ll use a polygon filter to isolate material in a model that will be excavated.

¢ You can find a list of Project Tables in the Project Manager on the left side of the
program window. Expand your view of these tables by clicking on the triangle
symbol P to the left of the Project Tables group.

e Then, expand the list of Map/Model Tables.

¢ Expand the Polygon Table heading to view a list of the polygon definitions stored in
the database.

e Double-click on the Polygon_02 polygon table to display the list of XY coordinates
in the polygon. Let’s assume that this polygon delineates the boundaries of an
excavation for an underground storage system.

e To view the polygon, click on the Plot button on the left side of this window.
e Choose the line style and color you like.

e Check on and off the following diagram items:
[ Background Image
[ Labeled Axes

¥ Map Overlays — Check on ¥ Symbols and ¥/ Borehole IDs under ¥ Borehole
Locations.
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"7 Other 2D Files
¥ Peripherals

¥ Be sure that the Color Legend, Scalebar and North Arrow are checked on.
" Border

e Click the Continue button and save the resulting Rw2D file as Excavation
Boundary.Rw2D.

e Close the Window displaying the map.
e Close the Polygon Table by clicking the Exit button.

Step 6: Use the Polygon Table to Edit your Ground Surface Model

e Select Grid | Filters | Polygon Clip.

e For the Input File (Grid), choose A-Horizon_Top.RwGrd.
e Name the Output File (Grid): Excavation Surface. RwGrd.
e For the Polygon Table, specify the Polygon 02 table.

Let’s assume that we want to excavate within the Polygon to an elevation of 1720 m.
e Under Filter Type, choose ™ Interior, and assign a New Interior Value of 1720.
e Uncheck the [' 2D Grid Map option.

e Insert a check for ¥ 3-D Grid Diagram.

¢ Click on the Continue button to display the new surface in a RockPlot3D tab.
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The excavation location should extend below the rest of the surface:

e Save the RockPlot3D scene as Excavation Surface.Rw3D and close RockPlot3D.

Step 7: Filter a Solid Model with a Surface

Next, you are going to isolate the material that needs to be excavated to get material
volume estimations. You’ll use a lithology model created in a previous exercise as an

initial model.

e Select Solid | Filter | Solid &
Grid(s).

e Under the Input/Output tab, be sure
that *Modify Existing Solid
Model is selected.

e For the Input Model choose the
Lithologyl.RwMod file that is
located in the Samples directory
(this was created in a previous
exercise).

If you were to view this model, it would
look similar the model to the right.

Lithology

(==
[ Jorawel
Il ostore
HETE™
| EC
W sitstore
[E

e Name the Output Model: Excavated Material. RwMod.
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Under the Filter Options tab, select * Single Surface. Choose the * Grid Model
option and specify the Grid File: Excavation Surface. RwGrd.

Check off I"" Modify Nodes Above Surface and check on ¥ Modify Nodes Below
Surface.

In the ¥ Modify Nodes Below Surface tab, choose © Replace All Nodes and
* Null(-1.0€27).

e Turn on the ™ 3-D Solid Diagram.
e Choose to display * Voxels under the Block Diagram tab.

e Check on and off the following diagram items
Striplogs

Draped Image

Floating Image

U B

Perimeter Cage
Legend(s)
Infrastructure

Faults

aman
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™ Other 3D Files

Click the Continue button.

Initially, your filtered model will be displayed using a gradational Hot to Cold color
scheme. To adjust this so that it is viewed with the colors in your Lithology Types
Table, double-click on the Grid-Filtered Solid item in the data tree.

Change the Color Scheme to the Lithology Table. Click on the Apply button, and
then close the Options window. Your diagram should look similar to the image
below, on the right.

You can add a Lithology Legend by choosing the Edit | Add Legend | Lithology
menu command.

Finally, append the Lithology Logs.Rw3D file so that you can see where the
excavated area is relative to your borings.
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Exercise 10: Use Image, CAD and GIS Files in RockPlot3D

This exercise will introduce you to the use of CAD and GIS files in RockPlot3D. It will
also walk you through draping an image in 3D.

Step 1: Import a DXF file into RockPlot2D and RockPlot3D

Open up a blank RockPlot2D window by clicking on the Plot2D button in the toolbar

in the upper right corner of the RockWorks window

In the new window, choose File | Import | DXF (AutoDesk Data eXchange
Format) to display the DXF (AutoCad) > RockPlot2D window.

For the DXF Input File, choose 2D_Tools_Import_Dxf Utilities.dxf. Check off the
following diagram items:

-

anamnn

-

Background Image
Labeled Axes

Map Overlays
Other 2D files
Peripherals

Border

Click Continue to display the window titled Set the Diagram Type and Coordinate
Units.

Make sure that the following settings are selected:

Click OK to display the DXF file in a new RockPlot2D tab.
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e Next, transfer the map into RockPlot3D by choosing File | Export | RockPlot/3D.

e Choose to ¥ Float the image and assign it an Elevation of 1770 m.

e Assign a Layer Name of Utilities.

e Uncheck the all of the Display items such as Striplogs and Perimeter Cage on the left.

e Click on the Continue button to display the map in a new RockPlot3D window.

e Save the image in RockPlot3D as Utilities.Rw3D and close the RockPlot2D -
RockPlot3D window. Save the 2D Map as Utilities. Rw2D when you close the DXF
- RockPlot2D window.

Step 2: Import a Shapefile into RockPlot2D and RockPlot3D

e Open a new RockPlot2D Window, choose File | Import | SHP (ESRI ArcView
Shape File).

e For the Input ESRI Shape File, choose 2D_Tools_Import_Shape_Streets.shp.
e Under the Shape Options tab, specify a Lines Style and Color.
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Click Continue at the bottom of the window to display the Set the Diagram Type
and Coordinate Units dialog box.

Confirm that the Units and Coordinate System match the project, and then click OK
to display the Shapefile.

Transfer it into RockPlot3D by choosing the File | Export | RockPlot/3D menu in the
RockPlot2D window.

Choose to ™ Float the image at 1770 m and assign a Layer Name: Streets. Click on
the Continue button.

Save the image in RockPlot3D as Streets 3D.Rw3D and close the window. Close the
Shape = RockPlot2D window without saving.

Step 3: Drape an aerial photo over a grid surface in RockPlot3D

Under the Graphics tools, select Images | Drape.
For the Image Source, select the * Project Image.

Under the second Drape Options tab, for the Grid Name, select the A-
Horizon_Top.RwGrd file.

For the Layer Name, enter Draped Airphoto.
Set the Vertical Offset to 0.

Click on the Continue button.

A RockPlot3D tab titled Draped Image is displayed, and the aerial photo is floating at
the indicated elevation.

Save this scene as Draped Image.rw3d.

Append the Streets 3D.rw3d file to the image by choosing the File | Append menu
command, and browsing for that file name. At the prompt "Do you want to overwrite
the current Stratigraphy, Lithology and Well Construction tables?", click on the No
button to see the floating streets appended to this view, slightly above the image.

Now, select File | Append again, (you can select No to the Save Warning prompt)
and select the Utilities.rw3d file. At the prompt "Do you want to overwrite the
current Stratigraphy, Lithology and Well Construction tables?", click on the No
button to display this layer floating just above the streets.

Choose the View | Dimensions menu command and change the Vertical
Exaggeration to 5. Click Apply to view the results.

Close the RockPlot3D window from this exercise without saving.
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Exercise 11: Lay Out a Report Page in ReportWorks

This exercise shows you how to create a printable page that includes different types of
RockPlot2D images, other graphic images, text, scalebars and more.

Step 1: Access a ReportWorks Window and Set Up the Paper Orientation

e In the RockWorks main window, click on the Report button B along the upper right
hand corner of the program screen. The ReportWorks program will launch and you’ll
see a new, blank window.

e Choose the File | Page Setup and click on the Printer | Select + Set button. Change
the Orientation to Landscape. The options that you see are dependent upon the
printer you have on your system. Click OK to return to the Page Setup window.
Click OK to return to the ReportWorks window.

Step 2: Combine a Log Profile with a Profile Location Map

e Click on the RockPlot (Rw2D) Tool button /&l or choose the Tools | RockPlot
(Rw2D) menu command.

e Draw a rectangular area on the blank page by clicking and holding the mouse cursor
in the upper-left corner of the page and dragging down and to the right. Release the
mouse button when you’ve got an area drawn like the following to display the
RockPlot Options dialog box.
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Draw a rectangle on the ReportWorks page to insert a Rw2D file.

RockPlot2D File: Click the small open-file button & at the upper prompt and browse
for the file named: Projected Section.Rw2D (This was created in a previous
exercise). If you don't have this file, choose the file rept_section.Rw2D.

Embed or Link: Click on the * Link radio button. With this setting, ReportWorks
will store the file name and path in the ReportWorks file. To include the contents of
the profile in the ReportWorks file, you would choose the Embed option.

Scaling: Choose ™ Best Fit (Equal). This tells ReportWorks to keep the horizontal
(profile distance) and vertical (profile elevation) scales equal. The scales are
displayed in the Current View section on the right.

Outline: Click the Outline tab at the top of the window. Change the Style from Solid
to None by clicking the down-arrow button.

Fill (Background): Click on this tab to set the background appearance. Be sure *
Stock Fills is selected, with the Style to None (for no fill).

Click the Apply button at the bottom of the window, and you’ll now see your log
profile displayed on the page. Click the Close button to close the dialog box.

Adjust the profile position on the layout sheet by clicking and dragging it.

Now we’ll insert a small map showing the position of this profile within the study area.

Again, click on the RockPlot button x| or choose Tools | RockPlot (Rw2D).

Draw a rectangular area below the profile by defining a square area as shown here.
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Position for Inserting Rw2D image

As before, click the yellow open-file folder and browse to the map named Profile
Plan.RW2D. If you do not have this file, use the file rept_map.Rw2D.

Click in the ™ Link button. As above, ReportWorks will read the image information
from the external file.

Scaling: Choose ™ Best Fit. As above, this sets the horizontal and vertical scales
equal. For the map, unlike the profile, the horizontal and vertical axes both represent
UTM map units.

Outline: Click this tab at the top of the window. Set the Style to None by clicking the
down-arrow button.

Fill (Background): Click on this tab to set the background appearance. Be sure
* Stock Fills is selected, with the Style to None (for no fill).

Click the Apply button, and you’ll now see your profile map displayed on the page.
Click to Close the dialog box. You can adjust its positioning as you wish.

Save this work in progress by choosing File | Save. Name the file Report. RwRpt.
The file name extension "RwRpt" is specific to the ReportWorks program.

Step 3: Append an Existing RwRpt File

In this step, you will append the page-in-progress with an existing ReportWorks image
file that contains a "standard" logo and company legend. In your own work you may find
it handy to create templates such as this and then append them to new drawings.
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e With the ReportWorks file Report. RwRpt still displayed in the ReportWorks
window, choose File | Append

e Browse for the file named rept_legend.RwRpt in the Samples folder and open it.

The program will add the contents of that file into the current drawing

e Notice the Layers panel on the left side of the screen, highlight the Layer 1 layer
with your mouse. When you select different layers, only those items will be editable.

e Adjust the position of the profile image and the map in the "company template" so
that the profile is in the top section and the map is in the lower section, to the left.
You can click-and-drag as well as resize as necessary. Use the right-click | Send to
Back and Bring to Front commands to help with stacking order. These are also
available in the Edit menu.

e Save these changes using File | Save.
Step 4: Add a Bitmap Image

In this step, you will add a BMP image to the drawing.

e C(Create a new layer by right clicking on the Layers pane and choosing New Layer. It
should be named Layer 3. Highlight the new layer so that the image will be added to
that layer.

¢ Click on the Raster (Bitmap) button &l or choose Tools | Raster (BMP, JPG,
TIFF).

e Draw a rectangular area to the right of the map by clicking and holding the mouse
cursor in the upper-left corner of the page and dragging down and to the right.
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Release the mouse button when you’ve got an area drawn like the blue rectangle
below.

Position for Inserting BMP image

The program will display a window where you’ll select the raster image file name and set
scaling.

Picture: Click the small open-file button & at the upper prompt to browse for the
sample file: 1955 _airphoto.png and double-click on that file name.

Embed or Link: Click on the * Link radio button.

Scaling: Choose ™ Best Fit. ReportWorks will keep the horizontal to vertical aspect
ratio at 1:1 as you size the bitmap.

Outline: Click this tab. Set the Style to None by clicking the down-arrow button.

Click Apply, and you’ll now see the image displayed on the page. Click the Close
button to close the dialog box.

Adjust the image’s position on the layout sheet by clicking and dragging it.
Remember that you can use the right-click | Send to Back and Bring to Front
options to help with stacking order of the layout items.

Choose File | Save to save the layout.

At this time, in your own work, you could send the page to your printer with the File |
Print command.
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Exercise 12: Overview of Gridding Algorithms for Contouring
Sparse Data in the RockWorks Utilities

This exercise will talk you through some "tricks" for creating contour maps of sparse
groundwater elevation and concentration data using RockWorks Utilities programs.

Step 1: Open an RwDat file in the RockWorks Datasheet

e Click on the Project Manager tab or pane.

e C(Click on the arrow to the left of the Datasheet Files to expand this heading.

e Double-click on the Maps_Sparse_Data.rwDat file to open it in the Datasheet tab.
Step 2: Create a Triangulated Contour Map of Groundwater Elevations

Let’s use the Triangulation Contours menu item to create a map showing well locations
and groundwater elevation information, along with groundwater elevation contours.

e From the Utilities section of icons choose the Maps | Triangulation Contours
option.

e Set the data columns to make sure that the program is looking in the proper columns
for Easting and Northing locations. For the Z column, choose GW Elevation.

e Click on Triangulation Contours | Contours, select to show ¥ Colored Intervals
with Min-Max scheme and ™ Contour Lines with Labels.
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e C(Clickonthe  Map Overlays and  Point Symbols and click on the Symbols tab.

e Here, make sure that ~ Uniform is checked on, and choose a symbol to represent
well locations. Dimensions can be set to Uniform at a size of 1. The other Symbols
tab options can be turned off.

e Click on the Symbol Labels tab to display the settings to customize your point map
labels.

0 On the Content tab, turn on the  Northeast Label, and set the Data
Column to Well, color to Black, Opaque background should be checked on
and the color should be Yellow. The Prefix field can be left blank.

0 Turnonthe Southwest label, and select the GW Elevation column.
Choose a background color, and leave the Prefix field blank here as well.

0 Click on the Dimensions tab and turn on the ~ Automatic Offset option.

Click on the  Border option and view the options for line style and margins.

Click the Continue button to display the map.

The 2D Triangulation tool uses simple triangulation to create contours. For some
datasets, this may be all you need to create a reasonable looking map. However, it will
often be necessary to create grid-based maps with smoother contour lines that extend to
the edge of the project. Note the increase in the groundwater elevation on the eastern
edge of the map. We’ll explore grid-based mapping tools in the next step.
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e To keep this map open so that you can compare it to the grid-based maps, click on the
Untitled tab at the top of the window, and drag the tab away from the window to
undock it.

Step 3: Create Grid-Based Maps of Groundwater Elevation using Inverse
Distance Interpolation

e In the ModOps section of the main window, choose the Grid | Create | XYZ >
Grid menu command.

e In the Data Source tab, set the Datasheet columns to Easting and. Be sure the Z
(Elevation) column is set to GW Elevation.

e Click on Grid File and name the output grid GW Elevation.RwGrd.

e In the Dimensions tab choose the ™ Variable (Based On Data Coordinates) option.
Click Manually Specify Number of Nodes and set the Node Density to 50.
! This is important. This dataset is not within the defined project dimensions.

e Under Algorithm, choose ™ Inverse Distance. Be sure that [~ Sector-Based
Searching is left unchecked.

e Under Options, turn on and off the following interpolation options:
Faulted

Decluster

Logarithmic

High Fidelity

Polyenhance

Densify

Maximum Distance

Z=Color

Smoothing

I T O L B B B

<]

e Check the ¥ 2D Grid Map item. Check on and off the following diagram options:
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e Uncheck the ! 3D Grid Diagram option.
e Click the Continue button.

You should get a contour map that looks similar to this:

The "bull’s eyes" that you see around the high and low points in the map are typical of
the Inverse Distance interpolation method. One way to resolve this is to decrease the
number of points used during interpolation.

e Click the Options tab to the left, to return to the menu settings.

e Click Grid Model | Algorithm, and change the Number of Points used for Inverse
Distance Interpolation to 4.
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Main Options }l_ Spatial Filter 1 I~ Time Filter IgStrat Rules I 3D Log Design l

Grid Model

Data Source Weighting Exponent:
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¥ 2D Grid Map Number of Points: 4 -

Grid File © Cumulative -
. [ Sector Based Searching
™ 3D Grid Diagram Di .
IMEensions | . Dip Sector Angle: |45 Degrees (8 Secto
Algorithm  Directional
Percent 15
Ojpfems  Distance to Point Map Units 200

@ Inverse Distance . -

o~ Kriging Inverse-Dis

e Click Continue to create a new map.

The resulting map should look like this:

The bull’s eye effect has been muted somewhat, but still may not be ideal. Let’s
experiment with some other interpolation methods to see if they do a better job.

Step 4: Create Grid-Based Maps of Groundwater Elevation using Kriging
and Triangulation Gridding

e Click the Options tab to the left, to return to the menu settings.

e Click Grid Model | Algorithm, and change the gridding method to * Kriging.
Change the Number of Neighbors from 16 to 4 in the lower part of the window.
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e C(lick the Continue button to create the map.

You should get a map similar to this one:

This may be more to your liking, but the general groundwater flow direction could still be
better represented along the borders of the map. For practice, let’s recreate the map using
the Triangulation gridding algorithm.

e Click the Options tab to the left, to return to the menu settings.
e Click Grid Model | Algorithm, and set the gridding method to * Triangulation.

e Click Continue to create the map.
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Unfortunately, there are some problems with edge effects in the resulting map as well.

In the next steps, we’ll experiment with the Densify and Polyenhance options to see how
they affect the shape of the contours.

Step 5: Experiment with the Densify and Polyenhance Gridding Options

First, let’s experiment with the Densify option.
e C(Click the Options tab to the left, to return to the menu settings.

e Click Grid Model | Algorithm, and change the gridding method back to * Inverse
Distance.

e Click Options and turn on ¥/ Densify. Set the Iterations to 3.

e C(Click Continue.
The following diagram compares the contour maps created with the Inverse Distance
interpolation algorithm, with the Densify option turned off and on. Notice the Densify

process (which adds additional control points to the dataset before interpolation using
triangulation) straightens out the contour lines to better match the data points.
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e Repeat the same steps using the Kriging algorithm, rather than Inverse Distance.

¢ You may wish to experiment with how increasing and decreasing the number of
Densify Iterations affects the shape of the contours.

Finally, let’s experiment with the Polyenhance option, which should be used for the
interpolation of surfaces following a trend that is generally reflected by the data already
(such as a groundwater elevation or structural surface).

e C(Click the Options tab to the left, to return to the menu settings.

e Click Grid Model | Algorithm, and change the gridding method back to * Inverse
Distance.
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e Under Options, turn on the Polyenhance option. Select a 2nd Order polynomial.
(The options that you’ve been experimenting with should stay checked on as well).

e C(Click Continue.

The resulting map should look similar to the one below.

If you experiment further with other interpolation methods such as Kriging and
Triangulation, you’ll notice that all of the maps look very similar, with just slight
differences in how the contour lines are drawn around the wells.

Using real world data, we’ve found the polynomials to the first, second and third order

are useful when creating groundwater contour maps — especially when the groundwater
gradient is fairly constant.
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Extra Credit: Create a Contour Map of Concentration Data

If you have time, experiment with creating contour maps of the Concentration data in the
Maps_Sparse_Data.RwDat file.

e Inthe XYZ > Grid window, click on Grid Model | Data Source and change the Z

(Elevation) column to Concentration.

e Click Grid File to change the name of the output grid file to Concentration.rwgrd

e Adjust the 2D Grid Map | Map Overlays | Point Symbols | Symbol Labels so that
the Southwest label is Concentration instead of GW Elevation.

B xvz - Grid

@ Options | B untitled X & untitled X 8 untitled X & untitled X B untitled X B untitled X

I *®
Instructions Setting

Main Options Il_ Spatial Filter 1 I~ Time Filter WﬂStrat. Rules ‘ 3D Log Design 1

Grid Model ¥ Colored Intervals

—

—

W Point Symbols J

¥ Symbols

“ Content

¥ Contour Lines

| @ 20 Grid Map

™ 3D Grid Diagram | - Labeled Cells

™ Gradient Vectors

I” Background Image

I” Labeled Axes

¥ Map Overlays J

I Other 2D Files ‘

™ Faults

I Borehole Locations
I™ Infrastructure

I US Public Land Grid

™ Polygons

W Symbol Labeli

Leader Lines
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e We recommend that you NOT use the Polyenhance option for this type of data.
Check this off under Grid Model | Options.

e Experiment with how the Contour Lines, Intervals, Logarithmic option affects the
shape and extents of the plume contours.
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Exercise 13: Map Arsenic Concentrations Over Time with
Animation

In this exercise, you will create a frequency histogram of all of the Arsenic
measurements, create a custom color table, create a contour map of the high Arsenic
values on each sampling date, and then create an time-based animation.

Step 1: Create a T-Data Histogram

e Under the Borehole Operation tools, choose T-Data | Histogram.
e Set the T-Data Track to: Arsenic.

e Verify that the following options are not selected.
" G Value Filter

[ Resample

e The Time Filter and Spatial Filter options are accessed using the tabs at the top of
the window. These should be unchecked as well.

[ Time Filter
[T Spatial Filter

e Check on ¥I Peripherals and ¥| Title (under the Peripherals tab), and change the
Primary Title to Histogram and the Secondary Title to: Arsenic — All Dates.

e The remaining diagram defaults should work well, but feel free to look at the options
that are available.

e C(Click the Continue button.
RockWorks will read all of the Arsenic measurements for all of the active boreholes, for

all of the dates listed, and display them in a frequency histogram. The horizontal axis
represents Arsenic concentrations, and the vertical axis represents percent.
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Note that the range of data along the X axis is from 0 to 400, with the vast bulk of the
measurements less than the mean of 11.9. Since the high values are very anomalous, it's
important that we create each of our concentration maps using the same color table so
that the low-to-high concentration/color relationships remain constant.

e Choose File | Save, save the RW2D file as: Arsenic Histogram All Dates.Rw2D.

e Close the window where the histogram is displayed.

Step 2: Create a Custom Color Table

e Back at the main RockWorks window, expand the Project Manager | Project
Tables | Map/Model Tables heading.

e Right-click on the Color Fill Table item, and select Add a Color Fill Table.

e Type in the name: Arsenic Concentrations and click OK to display the Color Fill
Table: Arsenic Concentrations dialog box.

You'll see a blank Color Fill table. Here, you can type in value ranges and choose a
specific color to be used to represent those values in a contour map. There are also tools
for creating quick gradational ranges.

e Click the Palette button in the toolbar to the left.

e Enter the Minimum value of 0 and the Maximum value of 400 (which corresponds
to our Arsenic concentration range). Set the Increment to 20 (which will result in 20
color divisions), and leave the Cycles at 1.

e Set the Color Schemes to Min/Max, and pick any color you like for the minimum
and maximum colors. Uncheck the Reverse Order (High to Low) checkbox.
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H Palettes — m} X

Data Range

Maximum: VirEzh

Color Scheme

omn/vec  (CHL )

O Min / Mid / Max

Cycles: :

[ Reverse Order (High to Low)

X Cancel

e  When you're ready, click OK, and
you'll see your 20 value increments
and the gradational colors.

e To adjust your colors, click the
Palette button again.

e To continue, click the Exit button
in the left toolbar.

Step 3: Create an Arsenic Statistics Map

e Select T-Data | Statistics Map.
e Set the T-Data Track to Arsenic.

e Set this map's filter date: At the top of
the page insert a checkbox for
Time Filter.

e (lick in the ® Exact button and set
the date to: 2/14/2017.

e Back in the Main Options tab, set the Map Type to: @ Z = Highest Value
e Assign on Output Grid name of: Arsenic_highs 02-14-17.RwGrd
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e Click on the Gridding Method tab and change the Algorithm to @ Inverse
Distance.

e Under the Options tab, you can keep the [¥| Decluster and ¥/ Smoothing options
checked on. Additionally, check on the ¥/ Logarithmic option.

e Check on the ¥/ 2D Grid Map item, and turn on and off the following display items:
Colored Intervals: Click on the tab as needed to set the following items.

EUIY

Choose the @ Custom Scheme.
Click the Edit button in the upper-right.

EUBEY

Select the Arsenic Concentrations table, which you just created, and click Ok.
Contour Lines

Labeled Cells

Gradient Vectors

Background Image

Labeled Axes

Map Overlays

I I I B

<]

¥ Borehole Locations
¥ Symbols

¥ Borehole ID's
Other 2D Files

¥ Peripherals

[T Title: Check this item OFF. You can leave the Scalebar and North Arrow
checked on if you prefer.

™ Border

-

e C(Click Continue to proceed.

RockWorks will read the Arsenic measurements for the indicated date, pick the highest
value for each location for that date, interpolate a grid model, store the grid under the
name Arsenic_highs_02-14-17.RwGrd and generate a color-contour map using your
custom table.

Note that depending on the interpolation methods that you experimented with in the
previous exercise, the contours you create may look slightly different than those
displayed in the following image.

e Experiment with various display and interpolation options until you find settings that
you are happy with.

116 RockWorks Training Manual - Exercises



Step 4: Create a Playlist to Create 3 additional Statistics Maps

Now that you have the map settings established, maps for the other dates should go
quickly. Let’s do this using a Playlist.

e C(Click the Playlist button in the upper right corner.
e Assign an Item Title of Arsenic 02-14-17 and click OK.

Next, set up the 05-15-2017 map.
e Return to the map options by clicking the Main Options tab.

e In the Time Filters tab on the top of the screen, set the Exact Date/Time filter to:
5/15/2017.

e In the Main Options tab, assign the Output Grid this name: Arsenic_highs 05-15-
17.RwGrd.

e Click the Playlist button to create a Playlist item: Arsenic 05-15-17.

Next, set up the 08-06-2017 map

¢ In the Time Filters tab on the top of the screen, set the Exact Date/Time filter to:
8/6/2017.

e In the Main Options tab, assign the Output Grid this name: Arsenic_highs 08-06-
17.RwGrd.

e Click the Playlist button to create a Playlist item: Arsenic 08-06-17.
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Last one! Set up the 11-18-2017 map.

In the Time Filters tab on the top of the screen, set the Exact Date/Time filter to:
11/18/2017.

In the Main Options tab, assign the Output Grid this name: Arsenic_highs 11-18-
17.RwGrd.

Click the Playlist button to create a Playlist item: Arsenic 11-18-17.

Once you have compiled the 4-step playlist, you can save it as Arsenic Statistics
Maps.RwPlaylist through the File menu in the Playlist tab.

Then, click the Process Playlist button, to run the playlists and create the RwGrd
files and maps.

Step 5: Create an Animation

In this step, we'll simply list the Arsenic .RwGrd files in a datasheet, and create an
animated MP4 showing the contours on the different dates.
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Click on the Datasheet tab to access the RockWorks Datasheet.

Go to File | Open and choose the Animate_Grids.RwDat file. This file includes a
list of arsenic grids, along with Dates for each grid.

Under the Graphics tools, go to Animate | Grids - Contour Map Animation.

Choose @ List of Models (Datasheet). Line up the Data Columns so that they are
assigned the appropriate input column.

Under the Grid Display tab, be sure that the @ Custom color scheme is selected, and
that the Arsenic Concentrations table is displayed. The program should remember
the 2D map settings that were used to create the arsenic concentration maps in the
previous step.

Take a look at the options available under the Output Options tab. Change the
Frames per Second setting to 5. This will slow the animation down a bit.
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¢ Finally, click the Continue button to create and view the MP4.
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Exercise 14: Advanced Lessons with Plume and Lithology
Models

In this exercise, you will:

e Retrieve two models you created earlier (Benzene and Lithology) and display them in
3D.

e Adjust the display of the lithology model to view the distribution of the Clay material
in relation to the Benzene hot spot.

e Create a 2D map representing the thickness of that clay layer.

e Create a 2D map representing the Benzene plume, and overlay these with
transparency applied.

e Draw a clipping polygon on this map and create a polygon table.

e Clip your Benzene and Lithology models with this polygon, and display them in 3D.

e Create a 3D display of this polygon as vertical barrier panels.

Step 1: Create an Isosurface Display of Benzene01.RwMod

e At the main RockWorks program window, access the Project Manager pane or
program tab.

e C(Click on the arrow to the left to expand the Solid Models heading.

e Double-click on the model named Benzene01.RwMmod, which you created in an
carlier lesson. You'll see the Solid Model = 3D Diagram window.

e Click on the Options tab at the top of the window.

e Don't worry about the Data Columns — the program will ignore these since no source
data points are being included in this drawing.

e Click on 3D Solid Diagram item and choose @' Isosurface

e Leave ' Include Isomesh unchecked and uncheck the remaining display options

e Click Continue at the bottom of the window.

RockWorks will display this model in the 3D window.
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e Double-click on the Solid Model item in the data tree to the left of the 3D isosurface,

to access the display options.

e Just below the middle of this window, look for the Iso-Level Value prompt, and type

n: 45

e Click Apply. You'll see the isosurface shrink significantly, now enclosing only
concentrations greater than 45.

e Click Close to close the RockPlot3D Options window.

e Let's save this view: Choose the File | Save or click the Save icon in the toolbar and

type in the name: Benzene01 Isosurface.Rw3D and click Save.
Step 2: Append a Lithology Model Scene

Now, let's append your previously-saved lithology block model.

e Go to File | Append and browse for the Rw3D file named: Lithology Model. Rw3D

and click Open.

e When prompted if you wish to Overwrite the Lithology or Stratigraphy Types tables,

click No.

RockWorks will append your lithology model display to the plume display.

e Let's filter the lithology model for a different material type. Double-click on the
Lithology Model item in the data tree.

e Look for the Filter settings in the middle of this window.

e Be sure the ¥/ Filter option is Filter
| Enabled V| Show Vol 949, 288,359312
checked, and set the Low value to - e

1.9 (by dragging the slider bar or LD_W '_')l' o e
by typing in the value) and the T 21
High value to 2.1. This will filter e 00

the view for the Clay voxels,
whose assigned "G" value is "2".

e Click Apply.
e Click the Close button to close the RockPlot 3D Options window.

You'll see the Benzene plume and the underlying Clay layers, as represented in the
lithology model.
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Take a moment to adjust the view, zooming in and out, rotating the image, etc.

Note that the Clay layer is pretty much continuous, without other materials
interbedded. This will be important when doing the next step in this exercise.

Choose File | Save As to save this combined scene under a new name.
Name this: Benzene01 Isosurface + Lithology.Rw3D
Close this display window.

Step 3: Create a Clay Isopach Map

RockWorks contains some nifty tools for creating surface or isopach models from
lithology block models. For this lesson, let's determine the thickness of the clay materials
in the previous view.
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Choose Lithology | 2D Isopach from the Borehole Operations.
Click on Input/Output under the Main Options.

For Input browse for: Lithologyl.RwMod. This is the solid model that was
displayed in the previous 3D scene.

For the Output Grid, type in the name: Clay Isopach RwGrd.
Set the Lithologic Unit to: Clay

Check 2D Grid Map and click the tab to view the options of what to show on the
map. Specify the following settings.

[ Contour Lines

[T Labeled Cells
[ Gradient Vectors
[ Background Image
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¥ Labeled Axes

0 Under Axis Titles / North, change the title back to: Easting
W Map Overlays

¥ Borehole Locations and check the =~ Symbols and  Borehole IDs to
display
[T Other 2D Files
" Peripherals
" Border

Output Options, choose to display and view options to save the output to your files.

e C(Click Continue.

RockWorks will read the lithology solid model and determine the uppermost and
lowermost elevations for the Clay voxels in each vertical column of nodes in the input
model. The thickness of this interval will be stored for the corresponding node in the
output grid model (RwGrd file). A "null" value is assigned to any grid nodes that do not
have any Clay within the original lithology block model.

IMPORTANT NOTE: This isopach process includes all materials between the uppermost
and lowermost clay voxels in the model - regardless of materials that lie between. This
tool should be used with caution when your lithology model contains many interspersed
lenses.
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Make note of the thickness values represented in this map. The blank spaces (white)
represent areas with no clay. The pink and blue areas represent thin zones, greens
medium-thick zones, and oranges and reds the thickest zones.

e Choose File | Save and save this map: Clay Isopach.Rw2D
e Close the Lithology 2D Isopach window.

Step 4: Create a Benzene Plume Map

In the previous chapter, you created a statistics map for some time-based data (Toluene).
In this step you'll do the same thing for the Benzene [-Data measurements.

e Choose I-Data | Statistics Map.

e Set the I-Data Track to: Benzene Soil

e Set the Map Type to: Z = Highest Value

e For the Output Grid name, enter: Benzene Soil Highs.RwGrd

e Clickonthe 2D Grid Map button to display the map options to the right.
e Add a check mark to the ¥/ Colored Intervals option and click on it.

e Add a check mark to ¥/ Omit Lows to hide low-value contours.

e Set the Low Cutoff Threshold to: 45.
This is the same minimum isolevel that we viewed in the 3D window.

e Be sure the ¥/ Peripherals, Color Legend option is checked so that a color legend
will be included in the map.

e Uncheck the “' 3D Grid Diagram option

e The remaining settings will work fine — click Continue to create your map.

Let's do some image preparation so that we can append this display to the Lithology
Isopach map.

e Expand the Layers pane on the right side of the mapping window to see the different
map layers. You can widen and lengthen that pane as necessary.
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e Check/uncheck the following so that only the contour bands and legend remain. You
need to rename these for this map so that they stay separate in the next step.

v
v

I T T O B

A

Default (double click and rename to Legend)

Contour Map.Contour Bands (Double click and rename to Benzene Contour
Bands)

Borehole Location Map.Boreholes.Symbols
Borehole Location Map.Boreholes.Labels
Borehole Location Map.Boreholes.Leaders
Borehole Location Map.Boreholes.Paths
Highest Benzene Soil.Border.Grid

Highest Benzene Soil.Border.Scalebars
Highest Benzene Soil.Border.Outer Border
North Arrow

Scalebar

e Double-click on the visible color contours in the map window.

e In the Colorfill Attributes dialog box, set the Opacity to: 60

e Click Apply, then click Cancel to close this dialog box.

e Choose File | Save and save this map as: Benzene Soil Highs.Rw2D.

Step 5: Append the Maps

e Select File | Append and browse for the isopach map: Clay Isopach.Rw2D
and click Open. (Don't pick the RwGrd file, pick the Rw2D file.)

RockWorks will append the clay contours on top of the benzene contours, and display the
combined map in a new plot window.
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e You can return the Benzene layer to the front of the display by right-clicking on the
Highest Benzene Soil.Contour.Bands layer name, and selecting Bring to Front.

Other layer tips: You can rename layers if you don't like the automatic names, and you
can delete layers entirely from the view.

e Click the Save button (or select File | Save) and name this combined map: Benzene
Soil Highs + Lithology Isopach.Rw2D and click Save.

Step 6: Draw a Polygon Boundary around the Plume
e Seclect the Draw | Line Types | Polygon menu command.

This will activate the polygon drawing tool. Note the Draw Polygon button at the bottom
of the window.

e Draw a polygon around the outside of the visible plume by clicking and releasing
your mouse to insert the vertices; you can insert these points in a clockwise or
counterclockwise fashion.

e  When you wish to close the polygon, double-click on the last vertex, and RockWorks
will display the polygon with the current fill settings on the map.
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Terminate the draw-polygon mode either by clicking on the main Edit arrow button
(upper left) or by clicking on the Draw Polygon button at the bottom of the window.

With the Edit arrow now selected, click on the polygon to select it, then right-click
on the polygon to display a pop-up menu.

In the pop-up menu, choose Save to Polygon Table.

Type in the name: Benzene Clipping Polygon
and click OK.

Close this map window; you do not need to save the drawing changes.

Close the Benzene Soil Highs map in the I-Data Statistics Map window.

Step 7: Clip your Lithology Model with Your Created Polygon

This will allow us to construct a 3D scene of just the area where the Benzene
concentrations are the highest. First, let's view the Polygon Table you just created.

Back at the main RockWorks window, access the Project Manager tab or pane, and
expand the Project Tables heading (at the top of the list), and expand the
Map/Model Tables item.

Expand the Polygon Tables heading and double-click on the table you just created:
Benzene Clipping Polygon to display the Polygon Table window.

In this table you'll see a list of X,Y coordinates that represent the vertices of the polygon
you drew in the previous step. This table editor offers a number of tools including the
ability to plot the polygon outline (via the Plot button to the left). There are also tools to
save this coordinate list to an external file for use in other applications.

RockWorks Training Manual 127



e Choose the File | Save As RwDat File menu command. RockWorks will display a
default export name of Benzene Clipping Polygon.RwDat.

e Click the Save button to accept this.
The program will save this polygon listing in your project folder.

Click the Exit button to close this window.

In the ModOps menu, choose the Solid | Filters | Polygon Clipping option.
e Set the Input Model to: Lithologyl.RwMod
e Set the Output Model name to: Lithology1l Clipped.RwMod

e Click on Options and set the Polygon Table to the table you just created and viewed,
Benzene Clipping Polygon

e Set the Operation to: '@ Replace Nodes Outside Polygon

e Set the Replacement Value to: Null (-1.0e27 = Undefined)

e Check the ¥/ 3D Solid Diagram option, and view the options to the right
e Click on the Block Diagram tab and choose @ Voxels and @ Full Voxel
e Turn off the other diagram options.

e Click Continue to clip the model and create the diagram
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Since this solid model filtering program is generic — it works with lithology solids as well
as real number solids, the image will be displayed using a default cold-to-hot color
scheme for the voxels. Let's change the coloration back to reflect the lithology types.

e Double-click on the Polygon-Filtered Solid item in the data tree to the left of the
diagram.

e In the options window, click Color Scheme and select Lithology Table from the
drop-down list.

e Click Apply — you'll see the colors change.

e Now let's filter again for the Clay voxels only: Insert a check in the ¥/ Filter box.
e Set the Low value to 1.9 and the High value to 2.1.
e Click Apply, and you'll see only the Clay layer in the clipped model.

e Click the Close button to close the options window.

Now let's append the Benzene plume scene.
e Choose the File | Append menu command.
e Click No when prompted if you wish to save changes (we'll save in a minute).

e Select the scene named: Benzene(1 Isosurface.Rw3D
and click the Open button.

e When prompted Do you want to overwrite the current Stratigraphy, Lithology and
Well Construction tables, click No.

You'll see the combined display: clipped lithology model and plume.

e Save this scene by choosing the File | Save and entering the name: Clipped
Lithology + Plume.Rw3D and click the Save button.

Let's take a moment to view this display.

e Choose the View | Compass Points | East menu command. This will generate a
head-on view of the scene from the east.

e Set the Zoom percent to 200%, as displayed in the upper toolbar.
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e Use your mouse to point to the upper part of the Benzene plume. Note the X, Y, and
Z (elevation) coordinates at that point will be displayed at the bottom of the plot
window. This can be useful to determine specific points in space.

e Point to any other portion of the plume or clay layer, and see that the XYZ
coordinates will be updated. RockPlot3D also includes a digitize tool that you can use
in your own work to capture coordinates from the 3D scene.

e Zoom in/out and rotate the display as you like, to get a good view of the scene.

e Ifyou have extra time, use File | Append to append any of the DXF or image files
you imported into RockPlot3D in an earlier lesson: Draped Image.Rw3D, Streets
3D.Rw3D and/or Utilities. Rw3D.

e C(Close this plot window.

Extra Credit: Create 3D Barrier Panels Along the Polygon Boundary

RockWorks contains a variety of miscellaneous 3D graphics tools in the Utilities | 3D
menu. In this extra credit lesson, we'll construct a 3D "perimeter" using the coordinates
which are stored in the Benzene Clipping Polygon table and which you exported to a
datasheet file.

The first step is to open the polygon vertex list into the datasheet.

e Click on the Datasheet tab below the main icon menu, choose the File | Open menu
option.

e Browse for the name Benzene Clipping Polygon.RwDat and click the Open button.
(You may need to choose to view all files in the browse window.)

RockWorks will list the polygon vertex coordinates in columns 1 and 2 in the datasheet.
We'll add two additional columns to the datasheet.

e Right-click on the column header for column 3 and select Column Properties.
¢ Change the Data Column title from 3 to Barrier Base.

e Now, to define the type of data which will be listed here, select the Linear (Z)
option, and verify the Units are set to Meters.

e Click the green arrow at the top, pointing to the right, to advance to column 4.

e Type in the new Column Title name as Barrier Top, select the Linear (Z) option
and verify the units are Meters.

e Click the “-” button next to Datasheet Setup to close these options.

The RockWorks polygon table does not duplicate the first coordinate pair at the end of
the listing to close the polygon, since it already knows it's supposed to be a polygon.
However, the tool we'll be using does not make that assumption (the barriers are assumed
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to be open) so we need to manually close the polygon by duplicating the first coordinate
pair at the end of the list.

e Use your mouse to select the first X Y coordinate pair, on row 1 of the listing
(columns 1 and 2).

e Right-click and select Copy (or just type Ctrl + C).

e Use your arrow keys on your keyboard to scroll down in the listing, until you reach
the first blank row.

e With the cell in the first column active, right-click and choose Paste (or just type Ctrl
+ V).

You should see the first coordinate pair now listed there.

e Enter a value of 1680 and 1770 in row 1 of the columns for Barrier Base and
Barrier Top. Copy and paste these values for the other rows with data. This way, all
panels will have 1680 and 1770 as base and top.

e For your reference, you can click on the small “+” button to the right of the datasheet
to expand the Datasheet Setup pane, where the datasheet’s coordinate system
information can be defined.

Choose File | Save to save this data to the project folder.

File name: Benzene Clipping Barriers.RwDat

Click Save. RockWorks will save this as an RwDat file.

Now, create the barrier display.
e In the icon menus above, choose Utilities | 3-D | Perimeter Wall.

e Set the Input Columns to:
X: Easting
Y: Northing
Z-Min (Elevation): Barrier Base
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Z-Max (Elevation): Barrier Top
e Choose any color for the 3D panels.

e C(Click Continue.

RockWorks will create vertical panels between the defined vertices and elevations in
RockPlot3D.

Append your clipped models:
e Choose the File | Append menu command.
e Click No at the prompt Do you want to save changes to the Perimeter Diagram?

e Locate your scene named: Clipped Lithology + Plume.Rw3D
and click the Open button.

e Click No at the prompt: Do you want to overwrite the current Stratigraphy, Lithology
and Well Construction Tables?

You'll see the lithology, plume, and barrier display. Note that there may be portions of
the clay voxels sticking outside of the perimeter panels, this is a result of the size of the
voxels. Solid models with finely-spaced voxels will appear less blocky.
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Notes:
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